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Using Presentation Studio

In Morningstar Direct™ Cloud Editions, Presentation Studio is the standalone tool for
creating custom presentations. With flexible charting and reporting capabilities, and
access to Morningstar databases, Presentation Studio helps you communicate the
data behind investments. You have control over both the content and format of your
presentations, enabling you to use charts, tables, images, and text to tell your story.

Overview
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Presentation Studio uses
charts, tables, images, and text
to communicate information
about investments.
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This guide describes the following topics:

» Introducing Presentation Studio (page 8)

» Working with Factsheets and Workbooks (page 22)

» Working with a Template (page 25)

» Working with Chart and Table Components (page 42)

» Using Workbook Settings and Component Settings (page 64)
» Creating a New Page (page 81)

MAORNINGSTAR
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Using Presentation Studio Overview

» Customizing a Component (page 89)

» Working with Headers, Footers, Images, and Watermarks (page 98)
» Creating a Template (page 116)

» Publishing a Presentation Studio Template (page 124)

» Creating a Batch Report (page 131)

» Using Components with Nonstandard Features (page 140)

Morningstar Direct Cloud Editions October 2018 7

MOHMNGSTAH © 2018 Morningstar. All Rights Reserved.



Introducing Presentation Studio

Overview

Introducing Presentation Studio

Presentation Studio uses Morningstar data (as well as custom data, model portfolios,
and custom benchmarks) to allow you to create reports with a predefined layout and
look, or one of your own design. You can present information in a variety of charts,

tables, and images, along with analysis and commentary from Morningstar Research.

This section helps you understand the following:

» Presentation Studio terminology (page 8)

» what you can create in Presentation Studio (page 10)

» how to download and install Presentation Studio (page 13)

» what you can do on the Presentation Studio Home page (page 15)

» what you can do in the Application Settings (page 17)

» how to change the colors used in charts throughout Presentation Studio
(page 17), and

» how Application Settings, Workbook Settings, and Component Settings relate to
each other (page 20).

Some of the terms used in Presentation Studio and this guide might be new to you.
They are defined in this table.

Term Definition

Factsheet A factsheet is a document containing information (rating,
performance, holdings, and so on) about an investment. It cannot
present information for multiple investments at once. It typically
presents key data as tables, charts, and text. To view a sample, see
What is a factsheet? on page 22.

Workbook A workbook is a detailed document (usually multiple pages)
containing comprehensive information (rating, performance,
holdings, and so on) on up to 50 investments. It is frequently used
to compare investments or model portfolios. To view a sample, see
What is a workbook? on page 24.

Report Areport is a document reflecting information for a specific
investment (or investments, in the case of a workbook). In this
guide, a report is a factsheet or a workbook.

Template A template is a Presentation Studio document created to serve as
the basis for a specific type of report. A template typically contains
text, charts, tables, and images selected to present information in
service of the template’s purpose. When a template is used as the
basis for a report, its content updates to reflect the investment(s)
selected for inclusion in the report. For more information, see
Working with a Template on page 25.

Overview

What Presentation
Studio terminology
do I need to know?

Morningstar Direct Cloud Editions October 2018
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Introducing Presentation Studio What Presentation Studio terminology do | need to know?

Term Definition

Morningstar template | A Morningstar template is created by Morningstar experts to serve
as the basis for a specific type of report. Morningstar templates are
included in Presentation Studio. For more information, see Working
with a Template on page 25.

Component A component is an element used to present a specific type of
information about an investment or investments. Tables, charts,
text, and images are components. Each of these is described in
this guide.

Component category | Tables and charts are categorized by function. For instance,
Markets, Time Series, and Holdings Analysis are different
component categories. Markets charts include Markets Growth
and Markets Trailing Returns Bar Chart, among others. Markets
tables include Markets Summary and Markets Historical
Performance, among others. For more information, see Working
with Chart and Table Components on page 42.

Morningstar Direct Cloud Editions October 2018 9
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Introducing Presentation Studio What can | create in Presentation Studio?

In Presentation Studio, you can create a variety of reports: workbook, factsheet, and What can | create in
retirement plan review, to name only a few. Presentation Studio?

The exciting part of Presentation Studio is that you can use Morningstar data and
research in a graphic page layout.

< Note: If you have not worked with page layout before, don't worry. The processes presented in
this guide do not require a background in design.

For instance, you can have a page divided into sections and laid out like this:

The cells are
outlined in light blue

MORNINGSTAR
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Introducing Presentation Studio What can | create in Presentation Studio?

With a few clicks, you can populate it with data and Morningstar research content, so
it looks like this:
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Introducing Presentation Studio

What can | create in Presentation Studio?

A report can contain many pages, and each page can have a different layout.
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Introducing Presentation Studio Exercise 1: Download and install Presentation Studio

Exercise 1: Download
and install
Presentation Studio

Presentation Studio is a standalone tool, separate from other Morningstar
cloud products. In this exercise, you will learn how to download and install
Presentation Studio.

To download and install Presentation Studio, do the following:

1. Click here. The Morningstar Presentation Studio home page opens.

2. Onthe right side of the page, in the Download area, click the download link.

- IH
'.G marningstar presentatior X J [ Presentation Studio x

C | @ Secure | https://presentationstudio.morningstar.com

* 0 6 A w 9 @

© Apps N Calendar-Global C % CTE Board - MyIss. References Personal P Hamilton Lottery Concur Release NotesSprez

MOORNINGSTAR Presentation Studio

Home Sample Reports Support

Presentation Studio

Download

Presentation Studio in Morningstar Direct makes it easy to leverage Momingstar's data and analytics, and
then transform your firm's investment staries into professional, compliance -approved, custom-branded

Use the link below to download the mast current
version of Momingstar Presentation Studio.

marketing pieces, fact sheets, product comparison workbooks, and presentations. The template design tool

enables home offices control aver layouts, allowing them to adapt their communications for a wide range of Pr ion Studio V3.19.032.20 - .
audiences. Users can drag-and-drop report companents from a library of professionally-designed charts, The lates.t VE?TSIOH
data tables, and graphs that quickly communicate complex investment information. Supporting data comes _number 1S dlsplay_ed
from Morningstar's database, as well as from your imported proprietary investment data, notes, scores, and Video in the download link.
commentary. Firms can create and regularly update report templates, then immediately distribute them

online to sales groups and other departments for use on Morningstar Direct and Report Portal — ] _ .

3. You are prompted to save the morningstarpresentationstudiosetup.exe file. Navigate to
a location on your system and click Save.

[ oen T RREEERR— |
- o
u'\‘.} - | & » Downloads » - | g | | Search Downloads Pl
Organize * MNew folder R (7]
. FMOutput 2 Mame Date moc *
. Book 1V = 2 - .l_l
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. China Spreadsheet Wy
: | DirectSetup_STG_X (9).exe 472572018
@ OneDrive - MORNINGSTAR INC £ (T E
. = ||l DirectSetup_STG_X (8).exe 472572018
. China Spreadsheet (2) 5 g
: 3 — D Framemaker_14_LREFD).exe 472472018
@) Creative Cloud Files X X X N
@ morningstarpresentationstudiosetup (1)...  3/23/201&
Ml morningstardirectsetup (36).exe 3/21/2018
Bl Desktop . .
T %2 epsonl3800.exe 3/12/2018
. Libraries .
o (| DirectSetup_UAT X.exe
:j Documents G ST
& Music b <L U |
Fi|eﬂame:| morningstarpresentationstudiosetup.exe | -
— Do not change the file name.
Save as type: ’Apphcatlon v]
“ Hide Folders [ Save ] ’ Cancel ]
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Introducing Presentation Studio Exercise 1: Download and install Presentation Studio

4. The action required in this step depends on your browser settings. Do one of
the following:

» |f the file name is displayed in the download area at the bottom of the browser,
click the file name and from the drop-down field, select Open. The Install Wizard
window opens.

» If the file name is not displayed in the download area of the browser, navigate to
the location where you saved the morningstarpresentationstudiosetup.exe file.
Double-click the file to launch the Install Wizard.

5. Follow the on-screen instructions in the Install Wizard.
6. When the installation is complete, launch Presentation Studio. The login screen opens.

7. Log in with your usual credentials for Momingstar Office®™ Cloud or a Morningstar
Direct cloud edition. The Presentation Studio Home page opens.

= Note: The Installation Wizard creates a shortcut to Presentation Studio on your desktop. You
can launch Presentation Studio at any time by clicking the shortcut icon.

1[# prasentation Srudic

MOORNINGSTAR Presentation Studio

& 3 i
[ @ Search Name

From here, you
can create new

_ Batch reports and
Workbook Factsheet : Plan Review T Allocation = Portfolio Management [l templates, as
well as access
7 existing ones
My Templates ‘ My Reports :' ‘: New Page \"‘

Name Type Layaut Version Date Craated Date Madi

> Asset Allocati 5

» Factsheets

» Workbooks
MOHN'NGSTAH Morningstar Direct Cloud Editions October 2018 14
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Introducing Presentation Studio What can | do on the Presentation Studio Home page?

The Home page is the starting point for your work in Presentation Studio. From here, What can | do on
you can open an existing report or template, or create a new report or template. the Presentation

i ?
= Note: See What Presentation Studio terminology do | need to know? on page 8 to review the Studio Home page?’

definitions of workbook, factsheet, template, and other terms.

"FM@”";'"di:—- h :-— m“ ;_ — — ;_‘2 —-:—- -:: A
MORNINBSIAH Preseﬂtation STUd|O A. Application
Settings icon
/ L Search Name
B. Tiles
Batch
Workbook aF Factsheet Plan Review Allocation == Portfolio Management [=
I ~
Iy Templates | My Reports :I ‘: New Page :'
Name Type Layout Version Date Created Date Mod
. C. Minimize bar
» Asset Allocation =
» Factsheets |
» Workbooks
A. Click the Application Settings icon to open the Application Settings. For information
about the Application Settings, see What can | do in the Application Settings? on
page 17.
B. Click a tile to create a new report of that type.
Morningstar Direct Cloud Editions October 2018 15
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Introducing Presentation Studio

What can | do on the Presentation Studio Home page?

C. Click the Minimize bar to reduce the size of the top portion of the Home page.

& Note: The Minimize bar is especially useful when viewing Presentation Studio on a
small screen

MOORNINGSTAR Presentation Studio

Q Search Name )

Warkbook Plan Review Asset Allocation Portfolio

Batch Management

C. If the top portion of
the Home page is
minimized (shown here),
click the Minimize bar
maximize it

\ Marningstar Templates

My Temptaes [ IEENERD ( Action v ) ( NewFalder ) ( NewPage )

MAORNINGSTAR Presentation Studio

{ Search Name

Batch
Management [z

Workbook Plan Review

+ et +|

Allocation

Portfolio

( Mew Page )

| Il My Templates | My Reports ) (

E. List of templates

D. Toggle

Name Type Layout Version Date Created Date Mo
> Asset Allocation <
v Factsheets

Attribution Highlights 3 Factshest Template [ Landscape 3198 8/10/2016 810/}

Attribution Highlights 4 Factsheet Template [ Portrait 3198 8/10/2016 8/10/]

Comprehensive Product Review Hew Factsheet Template [ Landscape jmln 10/26/2016 1079/,

Current Portfolio Analysis Factsheet Template [ Portrait 3.18.16 22172017 2/21J] or I'epOr'[S

Equity Attribution Detail Factsheet Template [ Landscape 3.19.8 8/10/2016 8/10/]

D. On the toggle, click a selection to display a list of Morningstar Templates, your
templates (My Templates), or your reports (My Reports).
E. The list reflects the selection on the toggle. From the list, you can do the following:
» Double-click an entry to open that template or report;
» Sort on any column by clicking the column header (Name, Type, and so on);
» Scroll down to see mare list entries; and
» Scroll right to display additional columns (Version, Owner, Permission, Date
Created, and Date Modified).

MAORNINGSTAR
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Introducing Presentation Studio What can | do in the Application Settings?

The Application Settings are comprised of options you can use to customize What can | do in the
Presentation Studio. The following are a few examples of features controlled in the Application Settings?
Application Settings window:

» language used in your reports

» fonts used in various text elements

» start and end dates used in your reports
» custom groupings, and

» default Display benchmarks.

The Application Settings affect reports and templates created in your installation of
Presentation Studio. In general, the settings apply only to new reports and templates;
existing reports and templates are not affected.

As an example of changing an application setting, update the colors used for charts to Exercise 2: Change
reflect those of your firm. the colors used in charts

To change the default colors to be used in charts, do the following:

1. On the Presentation Studio Home page, in the upper-right corner, click the Application
Settings icon. The Application Settings window opens.

MOORNINGSTAR Presentation Studio ™ P11 g st

Application Settings.

Q Search Name )

Asset
Plan Review —T Allocation o

Workbook =+

Morningstar Direct Cloud Editions October 2018 17
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Introducing Presentation Studio Exercise 2: Change the colors used in charts

2. Select the Display tab.

Application Settings IE
¥F| (il ¥ il Lo | L e Ll il Each tab offers options
Data | Attribution | Layout | Peer Group | Display | Grouping | Index Group | Style | Asset Exposure for different aspects
S — = of reports.
Investment 1 [_ v] [ . vl =
Investment 2 I - m -|
Investment 3 [, | v] [ ‘ vl
Investment 4 [_ '] [ v vl
Investment 5 [_ v] [ - -
Investment & [_ v] [ > vl
Investment 7 [_ v] [ & -|
LVECHTES [ = L] z The Display tab
Investment 5 [ 0 | shows the color used
E——— (- O = to represent each
investment in charts.
Investment 11 I_ v] I Fay - | &
Display Benchmarks
Display Benchmark 1 [_ v] [ &) v]
Display Benchmark 2 [_ v] [ =3 vl
Category Average
T—— - o
Reset | | oK | | Cancel |

3. Click the Investment 1 row to select it.

4. From the Color drop-down field, select Magenta.

Inwvestment 1

The yellow background

Investment 2 e
nvestmen indicates the selected row.

Inwvestment 2
Investment 4
Inwvestment 5
Investment &
Inwvestment 7

Investment &

Inwvestment &

Investment 10

Inwestment 11
Display Benchmarks

Display Benchmark 1

Display Benchmark 2

Category Average

Category Average

a 2
d
=
4
- —
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Introducing Presentation Studio

Exercise 2: Change the colors used in charts

5. Click the Investment 2 row to select it.

6. From the Color drop-down field, select Dark green.

Investment 1

: Investment 2
Investment 3
Investment 4
Investment 5
Investment &
Investment 7
Investment &
Investment 9
Investment 10

Investment 11

Display Benchmarks

Color

Display Benchmark 1

Display Benchmark 2

Category Average

Category Avarage

g
g
B . || a

7. Click OK. The Application Settings window closes.

You can also select colors for
Display Benchmarks and the
Category Averages.

These colors are used in the reports you create from this point on.

MAORNINGSTAR
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How do Application, Workbook, and Component Settings relate to each

Introducing Presentation Studio other?
In addition to Application Settings (which affect every new template and report you How do Application,
create), Presentation Studio includes two sets of more granular settings— Workbook Workbook, and

Settings and Component Settings. It is important to understand how Application Component Settings
Settings, Workbook Settings, and Component Settings relate to each other, as relate to each other?

summarized in the following table:

When you
customize a
setting here... This is the effect...

Application Settings | The new setting is applied to every template and report you
create from this point on. Existing templates and reports are not
affected, with the exception of time periods (discussed later in
this guide).

Workbook Settings | The new setting overrides the similar setting in Application
Settings. The workbook setting is applied throughout the report
(except in individual components with different customization in
the setting, which is described later in this section). The new
setting also affects any components you later add to the report.
Finally, if you use the report as the basis for another report or a
template, the Workbook Settings are in effect in the new report
or template.

Component Settings | The new setting overrides any similar setting in Workbook
Settings, but for only the selected component. If a report with

a custom setting in a component is used as the basis for another
report or a template, the new setting is in effect in the
component in a new report or template. In other words, the
components in the new report or template displays one-year
rolling windows, except for the one component, which displays
a two-year rolling window.

Suppose you are working on a report based on a template with a rolling window
setting of three years. The template perfectly suits the report with one exception: you
need to display a rolling window of one year throughout the report. Using Workbook
Settings, you can change the rolling window setting for the report, without affecting
other reports or templates.

Now, let’s further suppose that in this report (which now displays one-year rolling
window data), you want a specific component to display a two-year rolling window.
Using Component Settings, you can change the rolling window setting for the specific
component, without affecting other components in the report.

What happens to a component with a custom setting if the Workbook Settings for the
report or Application Settings change in a way that conflicts with the component’s
settings? The custom component setting is not affected by the change in Workbook or
Application Settings.

Morningstar Direct Cloud Editions October 2018 20
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How do Application, Workbook, and Component Settings relate to each
Introducing Presentation Studio other?

Think of it like this: the smaller the setting’s impact, the more powerful it is, as follows:

» Application Settings have a large impact, affecting all reports and templates you
create from that point on

» Workbook Settings affect only one report. They have a smaller impact than
Application Settings, therefore Workbook Settings take precedence over
Application Settings, but only in a single report; and

» Component Settings affect only one component. They have the smallest impact of
all; therefore Component Settings take precedence over Workbook Settings, but
only in a single component.

Exercises using Workbook Settings and Component Settings are covered later in
this guide.

Morningstar Direct Cloud Editions October 2018 21
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Working with Factsheets and Workbooks Overview

Working with Factsheets and Workbooks

This guide contains information about the most common Presentation Studio reports—  Overview
workbooks and factsheets. Whether you are working with a factsheet or a workbook,
the same charts, tables, and research content are available.

< Note: In this guide, when information is applicable to both a workbook and factsheet, the
word “report” is used to mean “workbook or factsheet.”

In this section, you will learn the following:

» what a factsheet is (page 22), and
» what a workbook is (page 24).

A factsheet is a document containing information (rating, performance, holdings, and What is a factsheet?
so on) about an investment. It cannot depict information for multiple investments. It
presents key data as tables, charts, and text.

The sample shown on the next page is based on the Morningstar template for an
Investment Detail Report and has a portrait layout (8.5" wide by 11" tall).
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Working with Factsheets and Workbooks What is a factsheet?

The called-out features are described in Working with a Template on page 25.
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Working with Factsheets and Workbooks

What is a workbook?

A workbook is a detailed document (usually multiple pages) containing comprehensive

information (rating, performance, holdings, and so on) for up to 50 investments. It is
frequently used to compare investments or model portfolios.

The sample page shown here is based on the Marningstar template for an Equity
Manager Analysis workbook and has a landscape layout (11" wide by 8.5" tall).
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Working with a Template Overview

Working with a Template

In Presentation Studio, the simplest way to create a new report is to base it on a Overview
template or an existing report.

The section helps you understand the following:

» why you should use a template or an existing report to create a new report
(page 25)

» how to select a template for a new report (page 26)

» how to use Search to select an investment for a new report (page 29)

» how to create a list of investments (page 36) and

» how to use a saved list to select investments to a new report (page 37).

You can customize the layout and content of your report, but keep in mind that the
person who created the template (also referred to as the template builder) might have
set limitations on what you can do.

In this section, you will work with the Morningstar Investment Performance factsheet
template. The process can also be used when working with a workbook template; a
portfolio template, however, is different. Working with a portfolio template is discussed
in Creating a Template on page 116.

By using a template or existing report as a starting point, you can create a new report Why should |
in a few simple steps. use a template or
an existing report to

Morningstar factsheet templates are designed to summarize data and information
create a new report?

about one investment. Morningstar workbook templates are designed to
comprehensively illustrate data and information about multiple investments.
Morningstar templates have been designed for many different scenarios (such as Stock
Analysis and Attribution Highlights), but the steps for using a template are consistent
throughout Presentation Studio.

If you want your report to closely resemble a Morningstar template, a custom template,
or an existing report, the overall process is as follows:

1. Open a template or report with design and content similar to what you want to create.
Select the investment(s) to be reflected in your report.

(Optional) Select the benchmarks to be used for comparison in your report

o™

(Optional) Modify the design (colors, font, page layout, and so on) and content (charts,
text, tables, and so on).

Morningstar Direct Cloud Editions October 2018 25
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Working with a Template Exercise 3: Select a template

In this exercise, the Morningstar Investment Performance Factsheet template is used Exercise 3: Select
to demonstrate the process of working with a factsheet template; however, the steps a template

for using any Morningstar template, a custom template, or an existing report are the

same, except where noted.

To create a new factsheet from a template, do the following:

1. On the Presentation Studio Home page, on the toggle, be sure the Morningstar
Templates tab is selected.

1[# presentation Studia

MORNINGSTAR Presentation Studio ® O

{ @ Search Name )

Batch
Workbook = Factsheet Plan Review —+ Allocation Portfolio s Management [2] Click here to view
R this list.
My Templates ‘ My Reports ) ‘\ New Page )
Name Type Layaut Version Date Created Date Mod(fl
» Asset Allocation =
» Factsheets
» Workbooks
The list of Morningstar template categories opens, displaying the following:
» Asset Allocation
» Factsheets, and
» Workbooks.
< Note: If you had selected My Templates, the list would display the custom templates available
to you. If you had selected My Reports, the list would display your existing reports.
Morningstar Direct Cloud Editions October 2018 26
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Working with a Template Exercise 3: Select a template

2. Click the arrow to the left of Factsheets. The Factsheet category expands to display the
Morningstar Factsheet templates.

Marningstar Templates My Templates | My Reports

Name

Click here to expand this option.
» Asset Allocation

| » Factsheets
» Workbooks

Morningstar Templates My Templates

Name Type Layout Version Date Creatad Dats Modified

If you
» Asset Allocation cannot see
v Factsheets all columns
Attribution Highlights 3 1izw Factsheet Template [ Landscaps 3198 8/10/2016 8/10/2016 shown here,
Attribution Highlights 4 He Factsheet Template [ Portrait 3198 8/10/2018 810/2018 scroll right.
Comprehensive Product Review New Factsheet Template [ Landscape 3183 11/20/2015 11/20/2015
Gurrent Portfolio Analysis New Factsheet Template [ Portrait 3185 5/24/2016 5/24/20168
Equity Attribution Detail N Factshest Templats [ Landscape 3198 8/10/2016 8/10/2016

3. Initially, the templates (or reports) are listed alphabetically. You can sort on any column
by clicking the column heading. Click the Layout column heading. The list sorts on that
column and an arrow appears next to the heading. To reverse the sort order, click the
arrow next to the heading.

Name Trpe ILI When you sort on
» Asset Allocation the Layout column,
all the Landscape
v Factsheets templates are
displayed togeth
Attribution Highlights 3 New Factsheet Template [Y Landscape a{st%?f[?)p oofgtﬁe I?;t
Comprehensive Product Review New Factsheet Template [Y Landscape and all the Portrait
templates are
Equity Attribution Detail Hew Factsheet Template [ Landscape further down.
Equity Attribution Highlights Mew. Factshest Template [ Landscape
MﬂHNlNGSﬂ\H Morningstar Direct Cloud Editions October 2018 27
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Working with a Template

Exercise 3: Select a template

4. In the list, scroll down and double-click Investment Performance Factsheet.

Marningstar Templates My Templates | My Reports ) New Page

Name
Fixed Income Manager Factsheet 3

Holdings Based Style Consistency

Investment Detail Report

Type
Factshest Template
Factsheet Template

Factshest Template

Investment Performance Factsheml

Marningstar ETF Analysis

Factsheet Template

Factshest Template

The Investments: Settings dialog box opens.

Open this template.

Investments: Settings [%]
The dialog box
Name Inception Date Category [ |Show Display Name Calculation Benchmark 1 Calculation Benchmark 2 Color Marker shows the
Y |Display Benchmark 1 = | @ [Display Benchmarkz = |@/) [ESEEM -| (@ ~| default

Display Banchmarks

calculation
Morningstar Categary I |8, (Display Benchmark 1 = |@,| [Display Benchmark2 =4 benchmarks,
Bast Fit Index BLY| B |Display Banchmark 1 = |@&| [Display Benchmark2 =4 d|sp|ay
Category Averags benchmarks,
&) [a] [Display Benchmarict @, [Display Benchmarcz =i and
Ql I J | | other settings.

| o H Qam:e\|

MAORNINGSTAR
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Working with a Template

Exercise 4: Select an investment

In the Investments: Settings dialog box, changing the default selections for
benchmarks, colors, and so on is optional, but you must select at least one investment

to be the focus of the report.

Exercise

In the Investments: Settings dialog box, the following fields are not filled in:

» Name

» Inception Date
» Category, and
» Display Name.

When you have selected an investment and it is displayed in the Name field, the
Inception Date, Category, and Display Name fields auto-fill.

4: Select

an investment

Investments: Settings

Inception Date Category

[ Show Display Name

Calculation Benchmark Color Marker

| af

Display Banchmarks

7]

[Display Benchmark 1 ~ |, [N ~| [® -

MPT Index ~|a

‘ [Marningstar categary Ini_+ | @

[Display Benchmark 1 ~ |3 [HEEEEE ~| (> ~|

Display Benchmarc 1 v |2 (NENEEN v) (G <) ‘

Category Avarage

‘ 2

| Display Benchmark 1~ |@ |

v | -I‘

[ r—

You must select
an investment
for a factsheet
or investments
for a workbook.

In this exercise, search for an investment to populate the factsheet. Do the following:

1. In the Investments: Settings dialog box, in the Name column, click the Search icon. The
Find Investment dialog box opens.

& Note: When creating a new workbook, you can also use search to select multiple investments.

Investments: Settings

Name

Inception Date _Category

[ Show Display Name

Calculation Benchmark Color Marker

[a] e Display Senchmark : ~ |4, [N ~| [ @ -]
Display Benchmarks
‘ [Marningstar Category Ini_+ | @ Ed] Display Benchmark 1 ~ |2 (IINEEED ~| (O =) ‘
MPTindex ~|8) ] (Disploy Benchrerk 1 ~ ]2,/ (NN -] (D ~]
Category Avarage
& ] (Disslay Benchmark s = @] |

- (& - ‘

[oc ] [smmen ]

A factsheet template

allows you to search for

only one investment.

MAORNINGSTAR
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Working with a Template

Exercise 4: Select an investment

2. Inthe Within area, click the Universes button, and from the drop-down field, select

Open End Funds.

3. Inthe Find By text field, type Fidelity Contrafund.

Find Investment

=L

Within

Find By

@ Universes () My Lists ) My Searches

Open End Funds -

[¥] Include Only Surviving Investments

) Contains

Available records

Total records:

Jump to record name:

| Fidelity Contrafund | Go

Help

0K Cancel

In the Open End Funds universe, you are searching for investments whose names begin
with Fidelity Contrafund.

< Note: Users who have access to the HFR database can select an HFR fund when setting up a
workbook or factsheet. The data populates using monthly returns.

You can also search your
' lists and saved searches.

MAORNINGSTAR
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Working with a Template

Exercise 4: Select an investment

4. Click Go. The investments meeting your search criteria are shown in the Available

records list.
Find Investment @
Within @ Universes ) My Lists () My Searches
Cpen End Funds -
Find By @ Begins with C) Contains
[¥ Include Only Surviving Investments
Fidelity Contrafund Go
Available records
Total records: 2
Jump to record name: Fidelity Contrafund
Fidelity® Contrafund® (USD,XNAS,FCNTX,Port+Perf,Oldest,RepPerf) o
Fidelity® Contrafund® K (USD,XNAS,FCNKX, Port+Perf, RepPerf) Two funds meet the search criteria.
Help OK Cancel

MAORNINGSTAR
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Working with a Template Exercise 4: Select an investment

5. Inthe Available Records list, select Fidelity® Contrafund®
(USD,XNAS, FCNTX,Port+Perf,Oldest, RepPerf).

< Note: Even if only one fund is displayed in Available Records, you must still select it to add it to
the report.

Find Investment &

Within @ Universes ) My Lists ) My Searches

Open End Funds

Find By @ Begins with (7)) Contains

[¥] Include Only Surviving Investments

Fidelity Contrafund Go

Available records
Total records: 2

Jump to record name: Fidelity Contrafund

Fidelity® Contrafund® (USD,XNAS,FCNTX, Port+Perf,Oldest, RepPerf) |
Fidelity® Contrafund® K (USD,XNAS,FCNKX, Port+Perf,RepPerf) More than one fund might

be displayed in the
Available Records list.

Help oK Cancel
6. Click OK. The Investment Settings dialog box is displayed.

Name Inception Date Category I:‘ Show Display Name Calculation Benchmark Color Marker The hlghllghted
Fidelity® Contrafund® Gy] | 5/17/1967 US OE Larg: Fidelity® Contrz [Display Benchmark 1 v[QJ . - ® - settings

Display Benchmarks aUtOmatiCa”y
Marningstar Catege v]@y] Display Benchmark 1 vlq’J E] g - Egaﬁ‘eagz‘beiigg
(MPTindex  ~|@ = (Display Benchmark 1 | 2| (NN ~| (B ~]| jnyestment.

Category Average
US OE Large Growth &/ 12/1/1925 Large Grow US OE Large Gr |(Display Benchmark 1 v |@] ] 1 -] [(© -]
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Working with a Template

Exercise 4: Select an investment

Click OK to close the dialog box. The factsheet window opens. The layout of the charts,

tables, and text was predetermined in the template, but the content is specific to the

investment you selected.

-
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Working with a Template

Exercise 4: Select an investment

8. At the top-left corner of the window, click the Application Settings icon and from
the menu, select Save As to give the report a name and save it. A dialog box opens.

Q Home Chart
New Factshaet Ctrl+N
Open Ctrl+0
Save Ctrl+5

Save As |

Save as Templata

Export

Send To

Share With

Exit

When you are creating a new report based
on a template or existing report, be sure to
select Save As), not Save (which overwrites
the template or existing report)

It is important to understand the Save options, which are described in the

following table:

When you are
working in a...

Report

And you select...

Save

The result is...

The report is updated.

Save As

A copy of the report is created as a new
report (with a name you enter). The
original report is unchanged from the
last time you saved it.

Save As Template

A copy of the report is created as a
template (with a name you enter). The
original report is unchanged from the
last time you saved it.

Template

Save

If you built the template, it is updated. If
you did not build the template (for
example, a Morningstar template), your
work is saved as a report. The template
is unchanged.

Save As

A copy of the template is created as a
report (with a name you enter). In other
words, when you are working with a
template (as you are here) and you
select Save As, a report is created. The
template is unchanged.

Save As Template

A copy of the template is created as a
new template (with a name you enter).
The original template is unchanged.

MAORNINGSTAR
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Working with a Template Exercise 4: Select an investment

9. Inthe Factsheet Name field, type FCNTX Factsheet, then click Save.

Presentation Studio E‘I

Factsheet Name | FCNTX [Factsheet |

You can use spaces

Saved Factsheat in report names.
Mame -
o =MyRepots [
i1
.'_
| Save H Cancel ‘

The report is stored in the My Reports folder and listed on the Presentation Studio Home
Page when My Reports is selected on the toggle.

& Note: On the Presentation Studio Home page, the new report is initially shown at the bottom
of the My Reports list.

MOORNINGSTAR Presentation Studio

f L Search Name

Asset
Allocation =i

Workbook = Factsheet i Plan Review T

A

— O N ™
MyTemplatesm | Action¥ ) ( NewFolder ) | NewPage )

s ;
|, Marningstar Templates

~

Y If you want to

) Name Type Layout immediately move
O UserFactsheet] Factsheet (7 Portrait itgzlrsﬁgtr)telgéglplace
) Vanguard Large Blend () Workbook [ Landscape | order. sort the

. Name column.

) XYZ Factsheet Factsheet [ Portrait

()| FCNTX Factshest Factsheet [ Portrait

Morningstar Direct Cloud Editions October 2018 35
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Working with a Template Exercise 5: Create a list of investments

10. Close the factsheet by doing one of the following:

» Click the Application Settings icon and select Exit, or
» Click the Close icon (X) in the upper-right corner of the window.

< Note: You can have only one report open at a time.

|[7 Practice Workbook - Presentation Studio - E@&J
¢ Home Chart Data Table Format % R @ |Feedback
[ew Workbook Ctri+N I]L i A i B ]
Dpen Ctrl+0 Table Text Image | Divide Page View Calculate >

Layout Calculate

If you try to close a report with
unsaved changes, you are
prompted to save.

Eave As

Fave as Template

Fxport

Fend To

Fhare with »

Periac: 4/12/2018 ta 4/30/2017
|-Exit |

In the next exercise, you need a list of investments. You can use one of your existing Exercise 5: Create a
lists, but you might find it easier to follow the steps in this guide if you replicate the list list of investments
used here.

To create a list matching the one in the exercise, do the following:

1. Inyour edition of Morningstar Direct Cloud, create a list containing the
following investments:

@ Note: The tickers are shown in parentheses so that if you want, you can use them when
creating the list.

v

ProShares Large Cap Core Plus (CSM)

ProShares S&P 500 Dividend Aristocrats (NOBL)
Vanguard S&P 500 ETF (V0O)

PSDR SSGA US Large Cap Low Volatility ETF (LGLV), and
» iShares Morningstar Large-Cap ETF (JKD).

2. Name the list Large Blend ETFs.

v

v

v

Morningstar Direct Cloud Editions October 2018 36

MOHMNGSTAH © 2018 Morningstar. All Rights Reserved.



Working with a Template Exercise 6: Select investments from a saved list

In this exercise, you will create a new workbook by selecting multiple investments from
a saved list.

The Morningstar template, Equity Manager Analysis, is used to demonstrate the
process of using a workbook template; however, the steps for using any Morningstar
template, a custom template, or an existing report are the same, except where noted.

< Note: To follow the steps here, you need a saved list with multiple managed investments,
such as equity funds or equity ETFs. If you created the list Large Blend ETFs in the previous
exercise, please use it here.

To add investments from a saved list to a new workbook, do the following:

1. On the Presentation Studio Home page, on the toggle, be sure the Morningstar
Templates tab is selected.

Exercise 6: Select
investments from
a saved list

2

Search Name

Plan Review —+ Allocation

Workbook ~ + [ Factsheet

MOORNINGSTAR Presentation Studio ® O

_|_

Be sure this option
is selected.

.
i Marningstar Templates My Templates | My Reports ) | NewPage )

2. Click the arrow to the left of Workbooks. The Workbooks category expands to display the
Morningstar workbook templates.

Marningstar Templates My Templates | My Reports :ﬁl

Name

r il Click here to expand this option

» Factsheets
» Workbooks

Morningstar Direct Cloud Editions October 2018
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Working with a Template

Exercise 6: Select investments from a saved list

3. Inthe list, double-click Equity Manager Analysis. (You might need to scroll down to
find this template.) The Investments: Settings dialog box opens.

< Note: In this exercise, the Equity Manager Analysis template is used to compare two funds.

MName

ings '-\"'F_'l'ﬁ [E5
Morningstar Templates My Templates

My Reparts

) ( NewPage )

» Asset Allocation

Typs

» Factsheets

v Workbooks

Current versus Proposed Porifolio Comparison

Workbook Template

Equity Manager Analysis

Fixed Income Manager Analysis

Workbook Template
Workbook Template

Open this template.

4. In the Investments: Settings dialog box, from the Saved Lists drop-down field, select
the name of a saved list. The Investments: Setting dialog box displays the investments
from the selected list.

Saved Lists

Select saved list...

[-]

+ Add | -

I:‘ Name

Display Ben

] (Mornd
] (mery

Category Av,

]

‘|

12 Open End<

2015 Score Top Bottom List
2015 Top Bottom Score Smiall Growth
2015CloudLisk<
2017-5investments$
investments

5* Lg Blend ETF US

ABC Fund®

American Century Emerging Markets
Apple Worldwida®
BlendTest

CatAwglist

CustomMames

Extended Performanca
Large Blend ETFs

Large Growth

LW and Active

Oakmark Select Rank

OE Categories
PerformanceReportRank
PGI Tast 2

m

Investments:

rle Category

I:‘ Show

A saved list allows you to quickly
access investments you have worked
with before.

PGI Test List
Portfolic Analysis
RankTest

Sample List
smallcap
SurvivorListRank
Survivorship
Survivorshipe
Survivorship2
SurvivorshipBias<
SurvivorshiplistForScreenCaps
SurvivorshipTraining

SurvivorshipTraining2

O =

MAORNINGSTAR
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Working with a Template

Exercise 6: Select investments from a saved list

5.

6.

In the Show column, note that the five checkboxes at the top of the list are selected

If an investment’s Show checkbox is not checked, it will not be included in the workbook.
To include only the top two investments in the workbook, clear the checkboxes for the
other investments.

Investments: Settings

Investments: Settings
Saved Lists [LE!"QE Blend ETFs v|
D Name Inception Date Category I:‘ Show Display Name
I:‘ ProShares Largs Cap Core Plu:_gij 7/13/2009 US Fund Large Blend ProShares Largs Cap Core |
D Vanguard S&P 500 ETF S,J 5/7/2010 US Fund Large Blend Vanguard S&P 500 ETF !n alistof mulﬂple
[F] wanguard S&P 500 ETF gj 9/7/2010 US Fund Large Blend Wanguard S&F 500 ETF g}:’g&}?ﬁgging‘és
[[] ProShares S&P 500 Dividend gj 10/9/2013 US Fund Large Blend ProShares S&P 500 Dividen are checked for
D SPDRE SSGA US Large Cap LlSJ 2/20/2012 US Fund Large Blend SPDR® SSGA US Large Cag the t(ip flv?
I:‘ ProShares S&P 500 Dividend ._EJ 10/3/2013 US Fund Large Blend ProShares S&P 500 Dividen MVEStments.
|:| iShares Morningstar Large-Ca:iJ £/28/2004 US Fund Large Elend I:‘ iShares Morningstar Large-
Display Benchmarks
D [Morningsizr Category It = l@\J
I:‘ [MF'T Index - ]_Q‘J D
Category Average
| [7] US Fund Large Blend G\J 7171524 Large Blend =] US Fund Large Elend

These investments
are the focus of
the workbook

Display Benchmarks

Saved Lists [Large Blend ETFs -

[ + Add | - Delete |
D Name Inception Date Category I:‘ Show Display Name
|:| ProShares Large Cap Caore F'IungJ 7/13/2009 US Fund Large Blend ProShares Large Cap Caore |
|:| Wanguard S&P 500 ETF g] S/7/2010 US Fund Large Blend Vanguard S&P 500 ETF
[[] vanguard S&P 500 ETF @J 9/7/2010 US Fund Large Blend @] Wanguard S&P 500 ETF
I:‘ ProShares S&P 500 Dividend .EJ 10/9/2013 US Fund Large Blend D ProShares S&P 500 Dividen
I:‘ SPDRE SS5GA US Large Cap ngj 2/20/2013 US Fund Large Blend DJ SPDRE SS5GA US Large Caj
I:‘ ProShares S&P 500 Dividend ..SJ 10/9/2013 US Fund Large Blend D ProShares S&P 500 Dividen
D iShares Morningstar Large-Caig.‘J &/28/2004 US Fund Large Blend I:‘ iShares Morningstar Large-

I:‘ [Mornings%ar Category It w [QJ
[E] (MPT ndex v|a [l
Category Average
| [[] us Fund Large Blend gj 7i1/1924 Large Blend | US Fund Large Blend
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Working with a Template

Exercise 6: Select investments from a saved list

7. Click OK. The new workbook opens.

150.0

0.0

z 170.0

10,0

1500

1900

4 130.0

1200
100
1wo.0

son

102012 o013 42000 1072018 1072018 2m018

—FRussell 1000 TR USD

— FroShares Large Cap Cors Flus

~—\Vangusrd SB7 500 ETF

6 Performance
Time Periac: 5/1/2013 t® 4/30/2017  Caicuiston Sencnmank: Ruszal 1000 TR USD

Information

Ratrn Stz 0 =

7 PraShares Large Cap Core Plus. 1082

Vanguard S&P 500 ETF 1017
Russeil 1000 TR USD 1n28

Performance .

EEEPMNSONBNRSS SIS S FE 50

8. At the top-left corner of the Presentation Studio window, click the Application Settings
icon and select Save As. A dialog box opens.

& o |

Mew Factshaet

Chart

Ctrl+M
Open Ctrl+0

Save Ctrl+5

Save As |

Save a5 Template

When you are creating a new report based on a
template, be sure to select Save As), not Save
(which overwrites the template).

Export

Send To .

Shara With "

Exit

— —
[ Untitled Workbook * - Presentation Studio — — 2 C=AE
£ | Home | Chart Data Table Format ¥ mE @D
o [ L e EE A e B} ) ] £ 2 k] ¥ i
Investments Waorkbook Page Chart Table Text Image Divide Page View Calculate Restore PDF PRT XPS Excel
Setting Insert Layout Calculate | Linking Export
kel 1 =3 k 4 6 17 g 10 11
z In the
Navigation
Manager Analysis pane,.chck a
i page icon to
= . view the page;
i o 57372012 s 473001 scroll to view
2 additional
203 h
page icons.
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Working with a Template Exercise 6: Select investments from a saved list

9. Inthe dialog box, in the Workbook Name field, enter ProShares-Vanguard then
click Save.

The report is stored in the My Reports folder and listed on the Presentation Studio Home
Page when My Reports is selected on the toggle.

Presentation Studio IEI

Workbook Mame | ProShares-Vanguard |

Saved Workbooks

Name

=
@ I My Reports = Once saved, you can access the
Colorworkbook workbook from the Presentation

Studio Home page.
ColorWorkbook3

Custom Workbook

Equity Manager Analysis

ESG bar chart

0Oakmark Holdings Comparison
PerformReport

Portfolio Comparison

ek LA s W ] (B

| Save H Cancel ‘

10. Close ProShares-Vanguard by doing one of the following:

» Click the Application Settings icon and select Exit, or
» Click the Close icon (X) in the upper-right corner of the window.

W ProShares-Vanguard - Presentation Studio [ =R ﬂ

| Q Home Chart Data Table Format * r. RO Feedhack
M Workbook Ctrl+M A
New ful Jala] ri A = L___]
Open Ctrl+0 it Table Text Image Divide Page  View >
Save ChHS Insert Layout If you try to close a report
% E £ F with unsaved changes, you
Save As are prompted to save.

Save as Template

Expaort
anager Analysis
|| Send To .
Share With . e

Period: 5712012 to 473072017

=] .,
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Working with Chart and Table Components

Overview

Working with Chart and Table Components

Components—charts, tables, and text—comprise the main content of a report.
The look of the components (color, font, title, and so on), as well as some of the content
(such as category and date range), is determined by settings in the following:

» the Presentation Studio Application Settings
» the Investments Settings

» the Workbook Settings, and

» the Component Settings.

@ Note: On a page with multiple companents, you might need to zoom in to see a component
more clearly or zoom out to view more of the page.

Return Date: 4/30/2017

Fidelity® Contrafund®

FCNTX Portfolio Date: 3/31/2017

Compuhl)igo }

Performance Relative to Peer Group Fidelity® Contrafund® - Risk

Pesr Group (3-35%): Funds - .5, - Large Growth  Calculation Benchmark: Russell 1000 Browsh TR USD Time Periodt 51/

e Top Quartile W 2nd Quartle  weem 3rd Quzrtle s Botom Quarsile Calrulation Benchmark:

fetum

St Dev

Shape Ratio

‘Sortino Aatio

Calmar fiatio

Best OQuarter

Wiorst Quarter
2011 Up Period Percent

Drag the control on
the Zoom slider to
enlarge or reduce

the display.

Performance s | E ﬂ m L-! m E g rm rm ﬁg m @ - e om

A Morningstar template contains charts, tables, text, and research content selected by
Morningstar analysts to best serve that template’s purpose, but you can easily replace,
change, or delete any component.

< Note: The same components are available in both factsheets and workbooks; however,
plan reviews and portfolios are more limited. Plan reviews and portfolios are not covered in
this guide.

This section helps you do the following:

understand what the Command bar is (page 43)

use the Command bar to replace a component (page 43)
understand what the Component bar is (page 49)

use the Component bar to replace a component (page 50)
resize a cell (page 53)

rearrange components (page 56)

delete a component (page 60), and

remove a cell (page 62).

vV vy VvV VvV vVVvYyYVvYyyYy
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Working with Chart and Table Components What is the Command bar?

At the top of the Presentation Studio window, you see the Command bar, from which What is the
you can access many of the design and content tools. The Command bar has four Command bar?
tabs—Home, Chart, Data Table, and Format. Within each of the tabs, icons are

categorized by action. For instance, on the Home tab, the Insert category contains the

tool icons Page, Chart, Table, Text, and Image—elements you would insert in a report.

The Command bar

|¢ Home Chart Data Table Format X W R Fﬁl lF“—dbaE,"—l
P L LY e A = |us) [ 2 b ¥ 4

The tools available in

— = - = the selected
| Setting Insert Layout Calculate Linking Export Command Bar tab

Investments Workbook Page Chart Table Text Image Divide Page Calculate Restore PODF  PPT XPS Excel

The action categories
(Setting, Insert, Layout, and
S0 on).

You might decide an existing component does not significantly contribute to Exercise 7: Use
your presentation and a different component (not currently in the report) would be the Command bar
more useful. to replace a component

When replacing components, you should understand the following:

» A table can be replaced with a chart and vice versa.

» A component from one category can be replaced with a component from another
category, and

» A table component requiring a full page (represented by a green icon on the
Component bar) cannot replace a component in a cell occupying only part of
a page.

Morningstar Direct Cloud Editions October 2018 43
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Working with Chart and Table Components

Exercise 7: Use the Command bar to replace a component

To use the Command bar to replace a component, do the following:

1. On the Presentation Studio Home page, on the toggle, sel
list of your reports, double-click FCNTX Factsheet.

ect My Reports, then in the

MOORNINGSTAR Presentation Studio

/ L Search Name

)

. Asset
Workbook Factsheet = B Plan Review Allocation +
- 7 ~ N N -
{_ Marningstar Templates | My Templat |_Action ¥ ) ( NewFolder ) { NewPage )
) Name & Type Layout
= = . Double-click here to open
) EqTempla Factsheet [ Portrait the report. ’
y Manager Analysis Workbook [Y Landscape
B |FCNTX Factshest | Factshest [ Portrait
) Investment Performance Factsheet Factsheet |_r| Partrait
2. Onthe Command bar, be sure the Home tab is selected.
3. Click the Chart icon.
Er] (] [ | (ll HBE A = ) (i £ M a4 X Note the
Investments  Workbook Page |Chart| Table Text Image Divide Page Calculate Restore PDF  PPT XPS  Excel highlighted
Satting Insert Layout Calculate Linking Export Se?ect?ons.
Morningstar Direct Cloud Editions October 2018 44
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Working with Chart and Table Components Exercise 7: Use the Command bar to replace a component

The Chart menu opens, displaying the chart categories (Markets, Performance, and so
on). When you select a category from the Chart menu, a window opens to the right,
showing representations and names of the chart components in that category.

o3 Home Chart Data Table Format X mE

e (] [ T A = [ [ 2 ! S 4

Investments  Workbook Page | Chart] Table Text Image Divide Page Calculate Restore PDF  PPT XPS  Excel

Markats

~zzm v/\,/‘-\ ;\/ 3 E
& Wi y | e E
rformance l'r l'-.hl ""I'l i | el

Aszzet Exposure

Holdings Analysis Markets Growth Markets Drawdowr Markets Trailing Markets Rolling Markets Periodic
Attribution

Snapshot Charts in the Markets category

Style Analysis

Time Series
Asset Flows
Multiple Returns
Lagend

All Charts

My Components

4. Click the Table icon. The Table menu opens, displaying the table categories (Markets,
Performance, and so on). When you select a category from the Table menu, a window
opens to the right showing graphic representations and names of the table components

in that category.
Q Home Chart Data Table Format
ar kel LY e [[EE| A [BF (i 3 #] X
Investments  Workbook Page Chart |Takble|] Text Image Divide Page Calculate Restors PDF PPT XPS  Excel
Satting ! Marksts
Performance

Aszset Exposure

Holdings Analysis

Attribution
T T 7 T -
g miaga: it g
Snapshaot bt IO A | ik 8-S FEE | Fiebe 813 Tt 13500
Style Analysis P e e P o :_:. . =
2  w eea e s [S=—tE v -
Time Series Single Investman Contribution / Attribution Multiple
Attribution Total ~ Attribution Detail Winners / Losers  Investment
Azset Flaws Table Table Attribution Total
Table
Multiple Returns
SRS Tables in the Attribution category
My Components
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Working with Chart and Table Components Exercise 7: Use the Command bar to replace a component

Notice the Performance Relative to Peer Group chart near the top of the report.

Fidelity® Contrafund® Return Date: 4/30/2017 Cumpum[
FCNTX Portfolio Date: 3/31,2017 I'm}
Parfarmancs Ralstiva to Pear Groug Fidality® Contrafumd® - Risk
Feer Broup (5-S5%): Funds - LS. - Lage Browih  Calcslotion Ssschmarkc Fussell 1000 Grovwth TR USD 1 The Chans and tab|es
B Top Qemrtie BN 2nd Cuarlile BN 3rd OQuaeiie NN Botiom Dusriis are in the report
= 2o because they were in
b e the template, but the
Lo 7 data is specific to the
= s fund—in this case,
= = Fidelity Contrafund.
£ 182
[EH 0.4
4370 213
e g2z
St & Comrifind® 1218 13 B4 £5 H15 rgzg Do Pz Faroen =0 BET
Eeal 1000 Browth TR USD 4 THE 8 1305 28 1 g Ean imE ==
o 153 H = b 5 TG | Averegelam 24 206
i Faze 1z sz Br 123 EE TE EnEmIs e31 ez
Hie Famein 3 ERH 418 i #E I Lmpimoe 234 =]
] & 0z 15 24 EE |
e Famein BT ] 43 TE s = izt
Longest Up Streai (W) 3 E
LRI ] s
1Nz 106
EER= 43T
3 3
Rolling Parformancs - 36 manth roling window -20E =50
nm 1371205 12205
273706 26
e T Wik Drasioves M) 7 z
Man Drawdows % E ] 24
e W Fmze Date £1/2015 172005
Waley Date I73I0E 2300E
- Fidality® Contrefund® - Markst Parformance
Ei €505 07 05 D2 10 T 12M 02 OF D4 S 06 OT M5 OSNDNIMEONOE M (Lol oo
e - Emic
—Fin sl [l e Bz S L Lo
Trailing Returnz o= X o
T2t masth T men Eros v T o Aot Eonen v 4= L
£ 3437 16000
Rt Comrunc® 1218 IS EM W4T RS S ERERE |
e TDMETAMTRISD A0 23 T SE IR0 SS0 IV T41E EE sEm oo it £
ek tion Rt gec E4H -
remar Ratia iges] 128
U Capture Rstia 16000
Down Caztune Ratia 5130 1e0.00
Lip Humer et o 100
Down Number 580 ass o
UpFeomt s 4] oo
Down Perosst Fabio T o.m
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Working with Chart and Table Components

Exercise 7: Use the Command bar to replace a component

5. To replace the Performance Relative to Peer Group chart with a Snapshot Data Relative
to Peer Group chart, select the Home tab, then select Chart > Snapshot.

6. Drag the Snapshot Data Relative to Peer Group icon to anywhere in the cell occupied
by the Performance Relative to Peer Group chart.

& Note: The area containing a component is called a cell.

o

Home

Chart

Data Table

Format

o

Investments

Setfing

sl

L

Workbook Page

e

Chart|| Table

A =

Text

|onim]

Image Divide Page

Markeats

Layout

View

1]
Caloulate
Calculate

vd
Restore

Linking |

PDF  PET

3

4

Performance
Aszset Exposure

Heoldings Analysis

Return Date: 4/30/2017

Attribution

| Snapshot I

Style Analysis

fund®

The new
component
proportionally
sizes to fit
the cell.

Time Series

Snapshot Data
Relative to Peer
Group

Asset Flows Supplementary

Data Bar Chart

Multiple Returns

Legend

All Charts

My Components

20a 206z

7. Inthe chart, click Calculate.

Fidelity® Contrafund® Return Date: 4/30/2017

FCNTX Portfolio Date: 3/31/2017

Relative to Peer Grou .
" Peer group data refreshes daily;

_ therefore, the Calculate button
B Top Ouartile B 3rd Cusride N Bottom Quartle appears in componen‘[s associated
with a peer group.

100
e

Peer Graup [3-95%): Funds - U.S. - Larpe Growth

mm 2nd Quartile

-10.0

Annual Report Net

Expense Retio

# e 1 S TELD

o Foiein 8 Ceciabini
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Working with Chart and Table Components

Exercise 7: Use the Command bar to replace a component

When the calculation finishes, the Snapshot Data Relative to Peer Group chart is
displayed and reflects the current data.

Faar Groug: (5-F5%]: Funds - 5. - Lange Growth

22
20

[ Top Quartil= w2 Cugrle s Srd Quartil

= Eornm Qutle

Fideli Contrafund® Return Date: 4/30/2017

e Company
FCNTX Portfolio Date: 3/31/2017 Logo
Relative to Peer Group Fidelity® Contrafund® - Risk

Time Period: 51,2012 1o 4302017

Caicuimtion Serchmadc: Fussal 1000 Growth TR USD

& =tum 1113
1E Std Dev 10z
1.4
12 Sherp= fimtia 15
1.0 2
He Sorting Fistin 3
LE Caimer fmtin 150
LE]
Aaruzl Raport Kt Expense Ratio Sagt Qusrier 1052
Worst Tusrter -470
LT e | M e
1D S nE s Wz 1] e
Finit @ [ontrzue i 13138 3%k E% £ HIE tezg Down Farin Perzem e
Fuszel 1000 Growth TR USD 14 70 H 1305 4 TRIp wmmge Ean 7
Sin Farcamle 183 557 ez 87E a4 2202 | Mwernge Loss 214
25t Percantie 1344 > 4] 1281 S 1788 Bein StdDev &3t
50t Perantie n# 308 EH RS 450 TEED Loss It Daw 554
Tith Prrantiz £ j1=3 142 4 I8 113k
S3th Parantin 527 -3 513 250 % 015 ™

i

T T

8. To save your work, click the Application Settings icon at the top-left corner of the

window and select Save.

ﬁ I Home | Chart

Mew Factshest
Open

Save

Save As

Save a5 Template

Export

Send To

Share With

Exit

Ctrl+N

Ctrl+0

Ctri+5

Note the highlighted selections.

The Snapshot Data
Relative to Peer
Group chart now
occupies the cell.

MAORNINGSTAR
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Working with Chart and Table Components

What is the Component bar?

At the bottom of the Presentation Studio window, you see the Component bar, which is
another way to access the chart and table components for your report. The Component
bar displays the following:

» the Component Category button

» the Component Settings button, which displays either Chart Settings or Table
Settings, and

» icons representing tables and charts in the selected component category.

@ Note: You cannot insert images or text components from the Component bar.

What is the
Component bar?

] ||

Asset Exposure | & [| Chart Settings |4 |- m El E ﬁ = T
- 4 k ¥

T

it

‘-"ﬁla

Component Category Component Settings Table and chart icons

This table lists the component categories (indicated by different colors) displayed in the
component bar.

This color... | represents this type of component...
Blue A chart
Orange A table
Green A table requiring a full page
< Note: The tables requiring a full page are Performance Reporting (Extended),
Holding Intersection, and Leading Contributors/Detractors.

In the Component bar, when you hover the cursor over a component icon, the icon
enlarges and a pop-up opens, displaying the component name and a representation of
the chart or table.

If you drag the cursor across the
Component bar, pop-ups open
as the cursor passes each icon.

ﬂ.“hni;q“

Calendar Returns Bar Chart

= [ (1 i M 2
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Working with Chart and Table Components Exercise 8: Use the Component bar to replace a component

You might decide an existing component does not contribute significantly to Exercise 8: Use
your presentation, and a different component (not currently on the page) would be the Component bar
more useful. You can select a chart or table icon from the Component bar. to replace a component

< Note: You cannot access text components from the Component bar.

When replacing components, you should understand the following:

» A table can be replaced with a chart and vice versa.

» A component from one category can be replaced with a component from another
category, and

» A table component requiring a full page (represented by a green icon on the
Component bar) cannot replace a component in a cell occupying only part of
a page.

In this exercise, a chart (Rolling Performance - 36 month rolling window) is replaced
with a table (Leading Contributors).

To use the Component bar to replace a component, do the following:

1. With the FCNTX Factsheet report open, at the bottom-left corner of the Presentation
Studio window, click the Component Category button. The Component Category
menu opens above the button.

2. Select Holdings Analysis. The icons on the Component bar now display only the
components in the Holdings Analysis category.

Markats
Performance
Aszet Exposure

Haldings Analysis

Attribution

Snapshot

The Component Category menu
displays the same categories
available on the Command bar.

Style Analysis
Time Series
Azset Flows

Multiple Returns

Legend

All Charts

All Tables

All Companents Click the Companent Category
button to access the

My Components Component Category menu.

- You night need to
Performance a | - ﬁ scroll to see more
g component icons.

Morningstar Direct Cloud Editions October 2018
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Working with Chart and Table Components Exercise 8: Use the Component bar to replace a component

3. Notice the Rolling Performance - 36 month rolling window chart on the left side of the
report. Replacing one component with another is a simple drag-and-drop action. To
replace the Rolling Performance - 36 month rolling window chart with a Leading
Contributors table, from the Component bar, drag the Leading Contributors table to the
cell occupied by the Rolling Performance - 36 month rolling window chart. The new
component proportionally resizes to fit the cell.

o 1 2 E 4 =3 & E i3
&
1
FCNTX Portfolio Date: 3/31/2017 Logo
Relative to Peer Group
Faar Broup (3-25%): Funds - U 5 - Large Grousth (|
= e Top Quartie = nd Quartle = 5rd Quartie s Bottam Quatie Caicalation Benchmenk Fuss
22 m Erkl
‘-: fatum 1213 138
1E St Dev 1z 1088
b Share Rtin 125 17
ni; Caimer futia 130 18
e ————— Eazt Dumemr 10m 1022
e : Worst Quarter -470 52
D s s m3 mz 2011 | Up Fened Fereert B0 B
4 Fidzfty® Contrafunde 1315 % 124 19 i 1525 Dowm Farios Faecan: = e II
Flussell 1000 Groweh TR USDH T 708 56T 1108 4 1525 Awmme Ban 27 2%
£ Faszentle hi<] agr 1+ nn Lt 2202 | Aversge Loz <214 -208
&th Peroentie B BEF &5 128 BB 1788 Bain Std Dev &3 853
ECth Parcantie nm EAE] a18 b= 3250 BEZ | Loss Std Dev 53¢ B2
5 T5th Peroentie 308 055 K 3 (L) nms 113 5
S5th Parcentie %) 355 313 480 ol 3 wmis = e [
Longest Up Etrmsk M) 7 L]
funUp% 1572 152
StertOmte 1m0z 1172008
Erd Dats 5312013 4302017 1
] — e — —— Longest Down Stresk Mo} 3 3
Rolling Performance - 36 month rolling window | Fun Dowm % 805 0
@ Leading Contributors ot} .
i e & Drag the Leading
e s : i|  Contributors icon to
Z Time Period: 8-1-2 0 7-31-21 e .
100 Portfolio: XYZ Portfolio bl the cel occupied by
. ortfolio: T the Rolling
- Weight Return [ Performance chart.
H 0505 07 06 03 10 11 12 01 @2 03 04 05 06 07 06 2f 10 11 | Holding 1 00.00 00.00
2 s Holding 2 00.00 00.00 o
| — idaie® Cortrafurd® = Fuzzal 1000 Growsh T USD LEEdiI’Ig Contribttors om
v
ai® . - E
—— - =
Holdings Analysis a | Chart Settings & |4 E m E FH m m m f | !-_:-’. it | It \ J '-\’ > B - 1t
4. If necessary, click Calculate.
Leading Contributors
Time Period: 312017 to 4302017
Click here to access the
itz Eormri most current data.
| Calculate |
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Working with Chart and Table Components Exercise 8: Use the Component bar to replace a component

When the calculation finishes, the Leading Contributors table is displayed.

Fidelity® Contrafund® Return Date: 4/30/2017 Co mpany
FCNTX Portfolio Date: 3/31/2017 Logo
Relative to Peer Group Fidelity® Contrafund® - Risk
Paer Groop (5-35%]: Funds - U.5. - Lag= Growth Time Pesiod: 51,2012 0 4302017
o Tog Quaie W Zng Qustle W G Quzie e Sgmom Qustl Cacstion Smncemark Fussel 1000 Growth T8 USD
o I Emit
12: Fetum 1318 1337
18 Sed e 0z 182
:;; Shanzs Rzt 123 17
s . £ =
: Zmeuz Razort Hiat Enpense fn Beest Chisewier EhE] 1084
Wiorst Qusrte a7 532
Rt e B Conaed 1200 Dot TERIT .
1M s Er 3 7 e e Feied Feroem =y s
Fiisity® Lontrsfinds 1318 1% BE £ Hig 1gzz Do Fered Feoent = ;T
Faszell 1000 Growsh TR UED e 708 H 130 154 18I Avmmgmian 27 2=
B Facale 153 557 08 1875 a 220 | Average loss 214 205
£t Parcansie 138 es: EE 128 n5 1785 Gan SoDev 53 b
£t Parcartie 3 215 418 088 450 1882 | 10ss St Dev 554 5
TSt Parcastie = 052 13 23 7 1BE
. Bk
St Parzantie & a5 313 450 o s
Longest Up Stresk (o] 7 E
Funlp % 1572 1523
StarOme 202 /206
End Date SALENS 4E0/2017
Jorgass Joee Sevmst o) : :
Leading Contributors Fum Dowm % Im
Time Fering: 3/1/2017 10 4302017 Stere et 13 200 YOUhhavfe replﬂced
a chart from the
- e ation | DR 2220 EE
e . .| Performance category
Fassbazkln: & 153 ). -~ - with a table from
 nepie in- e 257 | MaxDemvdaan a7 a4 ;
- - -|  the Holdings
[E——— 1233 053 | Pascate 12015 B i cateqon
iprabem ez 4 1272 05 | i 223208 3ae0s Y gory.
 activision Elzzerd Inc 37 s
Mphzh=t iz T 13T 042 | Fidelity® Contrafund® - Market Performance
TednInc 143 2457 035 | e Feriad: 5712012 o 4302017
| 4cbe Systams Inc 150 175 [ :
[Vise In Clzss & 23 1050 0z¢ L i

5. To save your work, click the Application Settings icon at the top-left corner of the
window and select Save.

a Home | Chart
Hew Factshaet Ctrl+N
Open Ctrl+0
Save | Ctrl+5
Note the highlighted selections.
Save Az

Save @5 Templats

Export

Send To .
Share With »
Exit
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Working with Chart and Table Components Exercise 9: Resize a cell

Although Morningstar templates are laid out carefully, they cannot account for Exercise 9: Resize a cell
all possibilities. Take a look at the FCNTX Factsheet and notice the following:

» The unlabeled table above the Leading Contributors table does not vertically fill its
cell, and
» The Leading Contributors table looks crowded.

The page would look better if the Leading Contributors table had more space and the
table above it had less. That sounds like a two-step process (enlarge one cell and
decrease the other), but it is actually only one. Simply move the border between the
two cells. When you enlarge a cell, an adjacent cell is decreased by the same amount
(and vice versa).

For instance, if you add space to the top of a cell (in other words, move its top border
up), the cell above it shrinks.

To resize a cell, do the following:

1. Select the Leading Contributors table and hover the cursor over its top border. A
two-headed arrow appears.

Fidelty® Contrafund® 1318 3.3 B4E 5 .21
Fussed 1000 Growsh TR USD 11.40 708 BT 13.05 BE 15.28
Z5th Percentile 154 B.53 1)) 1281 3.6 1788
ey = = =
TSth Percantil= =lv 058 142 E.30 3NTE 1335
centi
Leading Contributors | B This arrow can be dragged up or down.
Tim o 21/ 430
- o e = -
et Fetarn Confribution
Facebook Inc A [ 1529 1.0
Apgle inc 588 1683 057
Amzzon.com Inc 242 1233 .55
Aighabet Inc A im 1272 048
Acthision Slizzand inc 158 3073 047
MphabstIne G 578 1370 04
Teslz Inc 143 1457 0%
Adabe Systems Inc 150 175 3
Visalnc Class A 13 1050 0.24
UnitecHealth Eroup Inc 252 52 ¥
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Working with Chart and Table Components

Exercise 9: Resize a cell

2. Drag the arrow up to enlarge the cell containing the Leading Contributors table.

< Note: To resize a cell horizontally, select the cell, hover the cursor over one of the side borders,
then drag the arrow left or right.

3. Asyou drag the arrow, use the rulers at the top and left of the page as a guide. Release
the cursor when the ruler displays approximately 4.7".

Fiduity® Contrafund® 1310 3% BB 955 315 626
Fressal 1000 Geoaet TR LISD it.40 T8 SE7 1306 3548 1526
St Fercantibe 5.39 ko 0.E2 1578 4345 2m
4 Z5th Farpantile 1244 B33 EE1 128 3556 1188
5 .
As you resize a cell, the top
B — . | and side rulers display the
' 2 I s ——=1| " position of the border.
Figturn Contribution §
Facehook inc A& (2] 151 1.0
& Angls Inz 344 1889 057 :
Amazon.com Inc 243 1253 .55
Aghabst Ing & 37 1272 0%
MActivision Blizzard Inc 168 73 047
Nphaieting © 328 1370 04
- Teslaine 1.4 MET R
Adaise Systems Inc 150 1755
Visalnc Class & 23 1050
\niszdHesith Group Inc 252 5.4
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Working with Chart and Table Components

Exercise 9: Resize a cell

The result should now look like this.

FCNTX

Fidelity® Contrafund®

Return Date: 4/30/2017

Portfolio Date: 3/31/2017

Company

Logo

Relative to Peer Group

N Top Quartile W Znd Quartile

Piaar Group (5-95%): funds - LS. - Large Growih

B 3rd Quartile

I Boitom Cuartile

Fidelity'® Contrafund® - Risk

Time Period: 577,

201210 43072017

Calculation Benchmark: Fussell 1000 Srowth TR USD

23 v
2 2
15 = Aetm 1213
10
S e e nz
[T}
Zeveanl Fuzznt e Exzaran S Eharpe Ratio 1.5
: Sorting fiatio 3
¥ s 03 1 | Galmar fatio 1.50
Fidelity® Contrafund® 1218 1% % Sest Quader 152
Fuezzel 1000 Growts TA USD 140 708 1305 Worst Quartsr 470
e Farcamtile 153 257 1573 Up Ferind Fercen 500
25th Percentile 1544 653 1281 Dgwm Ferod Percent 35.00
S0th Perpentile 1n24 118 1055 178
Ttk Perpentile: 208 0= ) a9z
O5th Parcent E27 3 5 2
S5tk Percentile B2 13 L&) ¥ Ran St Dev a3t
Loss Std Dev 5.64
Leading Contributors
Time Peviod: 2/1/2017 1o 430/2017 "
Longest Up Streak (Mo )
Fascaled Rt
Wz 2t Fun o % 1572
Start Date 11202
Facetackinc A 843 152 -
End Date o523
Apgleinc 344 16.83
m Streak (Mo} 3
Amazon.com Ing 449 1253
Flun Down il
Alphsbet Inc & 37 1272 - _
Sari Datz 1217205
Acthision Blizzard Inc 58 kK] 7
End Date 2252015
Alphsbet Inc C 328 1370
Max Orawrdown (Mo} 7
Tesls iz 143 2457
Max Drawdown % B4
Adabe Systems inc 150 17.95 o
Peak Date 205
Wigalne Class & 13 1050 2 Velley D :
\UnitzdHesith Group Inc 52 i

-
s — B

8 o

i

o pa

o

Fidelity’® Contrafund® - Market Performance

4. Click the Application Settings icon at the top-left corner of the window and select Save.

Save zs Template

Export

Send To

Share With

Exit

5. Close FCNTX Factsheet.

n | Home | Chart
News Factshaet Ctrl+N
Open Ctrl+0
Save | Ctrl+S
Be sure to save frequently.
Save As

The components in
the right column
have not been
affected by the
changes to
components in the
left column.
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Working with Chart and Table Components

Exercise 10: Rearrange companents

You might want two components to switch places. For instance, if a component of
particular relevance to the report is displayed at the bottom of a page, and a less

relevant component is displayed at the top of the page, you might want the two
components to switch places.

< Note: In this exercise, swapping the positions of two components on the same page is
described, but you can also swap two components on different pages, as long as you can see
both at the same time. You would probably have to zoom out.

Switching the positions of
two components is a simple
drag-and-drop action.

5 - Becell 1 Frem
Flde[lt)"@ Contrafund® Benchmark 1: E.: Il 1000 Growth TR USD
Benchmark 2: 3&P 300 TR USD
FCNTX Category: US Fund Laroe Growth
Performance Investment Growth
1stQr 2ndQer 3rd O dsh Qe fizg| Time Ferios: 12012 32430720
M7 10.08 7l
26 58 i 2
s 4 L 7l
s 047 1 e
3 818 2 £3s
mz 149 -352  G&S51
Trailing Returns
=or Iymarm
Ak Ret 743 1008 7
Gid Dev A pli & oz 44z
A=t TEEE 1.4 2 a7 = Fiseity® Contrafund® 188!
Ast +-Index 15z 070 47 118 I, e - % Fank
3 Ca  ° Cat
Fidelityl Contrsfund® .13 08 136 43
Perfarimance Disclasure Fussell 1000 Browth TR S0 A0 L 7.08 n
The Dw
3 Median 25 3n
Count 79 A
Asset Allocation
] Smict
Cazn % 3 0.oo
US Enuity 3 5020 13
Fees and Expenses = i
B Hear-US Equity % 7.85 0.67
Wi Fronit Load - g E
£ s Biand % 0g2 0.0o
“ianagamen 053]
Other % 10 0.0
063
1261 Fee Equity Style Portfolio Statistics
- . _ Morningstar Equity Style Bex™  FE Ratig 75.08
Prospectus et Spense Ratio (=51 r =
] PIC A0 17.47
Oizfered Load ¥ i b
= P/ fatio B9
&
Marningstar Ratings Lo Mt Cap {mil) 98,953.14
Mamingstar fisting Overal *rETw] 3
Mamingstar fiating 3 T P
Mamingstar 7 **x*| | Fixed Income Style Partfoli Statistics
Mamingstar *TXUXE| | Memimgeter Picad lncama SedeBS=™ | ppen oo
SEEEH NS VESE L BE Matrity
o Eff M
Mamingstar fetum .13 1296 B0 2wa Credit Ouakty
Mamingstar Risk 1.10 15 232 Not Available oy Coupan -
vy Goupo 44
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Working with Chart and Table Components

Exercise 10: Rearrange components

To switch the positions of two components, do the following:

1.
2.

Open ProShares-Vanguard.

In the Navigation pane, scroll down and click page 9.

ke

Home |

Chart

Data Table Fi

o b

Setting

- 1Ty I A |

Investments  Workbook Page Chart Table Text Imag

Insert

Manager Analysis

Investment Growth
Time Pariag: 57172012 to 473072017
150.0

1E2.5

1750
1E7.5
1e0.0
152.5
1450
137.5
1304
122.5
1150
107.5
100.0

ErE
1072012 4201

— iShares Core S&F 500

Performance

Time Perloo: 5712012 to 47302017  Ca|

IShares Cone SBP SO0
Wanguars Dividend Appreciation ETF
Ruszell 1000 TR USD

Click here to display page 9.
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Working with Chart and Table Components Exercise 10: Rearrange components

On page 9, you see the Holdings-Based Style Map and Holdings-Based Style Trail near
the top of the page, and the Returns-Based Style Map and Returns-Based Style
Allocation at the bottom. If the Holdings-Based Style Trail chart and the Returns-Based
Style Map switch places, the Holdings-Based components will be displayed on the left
and the returns-based components on the right.

Manager Analysis M(’)HNNBS]AH

o
Holdings-Based Style Map Holdings-Based Style Trail X
=, me Feriod: 5/31/2012 to 4/30/2017 HOldmgS'baSEd charts

Giant

Large

= A

£ I 12
£ I8
& |&
N 1B
b i£
= i

Deap-Usi Care-wal Cors  Core-GrehHIgh-Gren
De=p-Vsl Core-\al Core Core-GrihiHigh-Grth

Returns-Based Style Map Returns-Based Style Allocation

Time Feriag: 5/1/2012 to 4/30/2017 Time Feriod: 5/1/2012 ta 4/30,2007 Returns-based charts
® |Shares Core S&F 500 1000
- Vanguarc Dividend Appredatian ETF
& Ruscas 1000 TR USD o0
= a
Marningatar % Marningstar €0.0
US Lange val US Large
TR usD Growth TR
usD 40.0
200
8.7
245 37 1E 4.3
| e 2D
0.0 .
L . Morningszar US Large Marningstar LS Large Morningstar US SmasMorningstar LS Small
Marningstar Marningstar Val TR USD Growth TR USD val TR UsD Growth TR USD
US Smail val us small
TR USD Growth TR
vED
= rwe Czre s 502 miangies Suitens zaeratan TS Mamd 1000TR 0D

3. Click the Holdings-Based Style Trail chart to select it.

Manager Analysis M(’)HNNBS]AH

Ildings-Based Style Trail
me Feriod: 573172012 to 4/30/2017 When a component is
3 3 selected, it displays a

et R e blue border.

Holdings-Based Style Map

Giant

Large

Small M

Micro

ap-iyl Conesyal Cors  Core-GnHIgh-Gtn
De=p-Vial Core-\al Core Core-GrthiHigh-Grth

Returns-Based Style Map Returns-Based m:u:aﬁon
Tima Pariac: 5/1/2012 to £/30/2017 Time: Feriod: 5/1/2012 ta 4/30/2017
® |Shzres Core S&P 500 100.0
= Vanguare Dividend Appreciztion ETF
© Russes 1000 TR USD e
= a
Marningstar % Marningstar £0.0 S55.8
US Largs val US Large S0 P
TR USD Growth TR . 422 g4y 423
uso 0.0
200
a7 £
a5 a7 18 mn 23
oo [N L
L u Morningstar US Large Marningstar US Large Morningstar US SmaliMorningstar LS Small
Marningstar Marningstar val TR USD Growth TR USD: val TRUZD Grawth TR USD
US Smail val us small
TR USD Growth TR

uso
= Eaees S EAF 330 WangaatE Quidng Azewsasit @ MRaanel 1000 TR LD
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Working with Chart and Table Components

Exercise 10: Rearrange companents

4. Drag the Holdings-Based Style Trail chart to the cell occupied by Returns-Based Style
Map. The two components switch places.

Manager Analysis

MORNINGSTAR

Geant

Large

s

Miern

Dm=p-ial Core-Val Cors Cor=-GrthHigh-Grih

Returns-Based Style Map

7 | ime Perog: 55172012 to 4302007

& i a
Marningstar

é Marningstar
US Large vl US Large
TRUSD Growth TR
] L]
Harningstar Marningstar
US Small vl US Small
uso Growth TR
uso

IShares Cars SBF 500
4 Vanguard Dividend Appraciatian ETF|
© Russail 1000 TR USD

The two

Holdings-Based Style Trail

Time Perioc: /3172012 ta &/30/2017

lant

H Mig Largs

Micra

Desp-val Cone-¥al Care  Cors-GrthHigh-Grin

Returns-Based Style Allocation
Time Fenon: 5/1/2012 to 47302017

o 1oco
]

£2.0 .

el TR USD Growth TR USD wal TR USDH

5rares Cxe 545 530 Wvacgunt Dhvzens Anavechitin §

B
447 | 428 a0 423
.
- | I —
8.7
45 37 - 43
i A [ 1B o

Morningstar US Largs Mamningstar US Lange Momingstar US SmallMarningstar US Small
Growth TR USD

STE Wunw 1200 TR UED

components have
switched places.

5. To save your work, click the Application Settings icon at the top-left corner of the

window and select Save.

a Home

Chart

New Factsheet Ctrl+N

Open Ctrl+0

Save Ctrl+s

Save As
Save 25 Template

Export

Exit

Send To »

Shars With »

Be sure to save frequently.
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Working with Chart and Table Components

Exercise 11: Delete a component

You might decide an existing component is not particularly relevant to your
presentation, or you might have another reason for deleting it.

To delete a component, do the following:

1. In ProShares-Vanguard, in the Navigation pane, scroll down and click page 12 (the

last page).

2. Select the Estimated Net Flow $Mil (Month-End) table.

Exercise 11: Delete
a component

Manager Analysis

MOMNGSA

Estimated Net Flow (Month-End)

5A,000.0M

Click anywhere in the
table’s cell to select it.

IShares Core SEF 500 5,300
Vanguard Dividend Apareciation ETF 0

Russzll 1000 TR USD -

11,917
-1 231

18,973

25,304 38,752

575 745

50,000.0M 4245320
40,000.0M
3475234
30,000.0M
25,5083
20,000.00 A8.522.94.
1151704

10,000.0M T

300 4,728.1M

[ e ez res
oM
-2z EEET
-10,000.0M
1 Merth 3 Marh & Mantn v 3 vaars 5 rears
= Zhares Core S&F 500 == yanguard Divicend Appreciation ETF > Russell 1000 TR USD
Estimated Net Flow sMil (Month-End)
1 manth 3 manths & months 1year 3 years s years

48,455
2,728

3. Right-click and select Delete.

Paste Ceri+v
Dalete Del I
The options displayed on the

Show Title menu change, depending on
57| o uthor and Date what is selected.

Benchmark Description »

Dynamic Text »

ETF Research

Global Fund Report .

Investment Strategy »
v Manager Biography »

Manager Narratives

A confirmation alert opens.

i o e You must click Yes in the

confirmation alert to delete

Are you sure you want to delete the component? the selected component.

I Yes | No
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Working with Chart and Table Components

Exercise 11: Delete a component

4. In the confirmation alert, click Yes. The component is deleted, but the cell it occupied is

still selected.

Manager Analysis

MOMNGSAR

Estimated Net Flow (Month-End)

50,000.0M
50,000.0M
40,000.0M
30,000.0M
20,000.0M

11,317.0M
10,000.0M

6,300.1M
-
oM
~10,000.0M
1 Morth 3 Manth

W (Znares Core S&F 300

-zmTM

43,452.28

34,752.3M

25,508.2M

18,572.5M

2,722.1M

-251.1M

& Mantn 1 a2

W Vanguzrd Dividend Appreciztian ETF X_Russall 1000 TR USD

Note the blue border
on the selected cell.

(o to the next exercise, Exercise 12 on page 62, to learn how to remave the empty cell.
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Working with Chart and Table Components

Exercise 12: Remove a cell

Although you deleted the component below the Estimated Net Flow (Month-End)
chart, the chart did not resize to fill the available space. Allocating the space to

the Estimated Net Flow (Month-End) chart requires you to remove the empty cell and
then resize the Estimated Net Flow (Month-End) chart’s cell.

Do the following:

1. In ProShares-Vanguard, select the empty cell.

2. Right-click and select Delete.

Estimated Net Flow (Month-End)

60,000.0M
50,000.08M
40,000.0M
30,000.0M
20,000.0M
10,000.0M & 300.1m

oM

-10,000.0M
1 Morth 3 Manth

Ehares Core S&F 500

Delete

13,572.3M

E Mantn

BN vanguard Divicend Appn

Del :
= The selected cell is

outlined in blue.

Exercise 12: Remove
a cell

MAORNINGSTAR

Morningstar Direct Cloud Editions October 2018
© 2018 Morningstar. All Rights Reserved.

62



Working with Chart and Table Components

Exercise 12: Remove a cell

When the empty cell is removed, the component above it (Estimated Net Flow
(Month-End)) resizes to use that area.

S MORNINGSTAR
Estimated Net Flow {Month-End)
50,000.0M 4E,459.2M
45,000.0M
40,000.0M
35.000.0M SaT=Z 3
30.000.0M
25,504.2M
25.000.0M
20,000.0M 13,572.3M
15,000.0M
11,517.0M
10,000.04
5,300.1M
5,000.0M
0.2M 574.5M 745.2M
o.om
-zETH ~zE1am
-5.000.0M
1 Manth 3 Mantn & Mantn 1vear 3 vears 5 veass
== rShares Core S&F 500 == yanguard Civicend ETF X _FRussall 1000 TR USD

3. To save your work, click the Application Settings icon at the top-left corner of the
window and select Save.

[Mew Factshaet Ctrl+N
Open Ctrl+0
Save Ctrl+8
Be sure to save frequently.
Save As

Save 25 Template

Export

Send To »
Shars With »
Exit

The chart now
occupies the
full page area.
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Using Workbook Settings and Component Settings Overview

Using Workbook Settings and Component Settings

In What can | do in the Application Settings? on page 17, you learned how to select Overview
features to be used in all the reports you create from that point on. In this section, you

will learn how to select features that affect only a specific report or component. You

will learn how to modify and create time periods.

Before starting the exercises, you might want to review How do Application,
Workbook, and Component Settings relate to each other? on page 20.

This section helps you do the following:

understand what Workbook Settings are (page 64)

understand your options when changing a time period (page 65)
understand the Start Date and End Date selections (page 66)
modify the Start Date and End Date for a report (page 68)
understand what Component Settings are (page 71)

modify the Start Date and End Date for a component (page 71)
understand what a linked time period is (page 74)

create multiple time periods (page 75), and

apply a time period (page 77), and

reset a time period (page 79).

vV VvV VY Vv VvV VvVVvVY

Workbook Settings are options specific to a single report. These options can affect What are
various aspects of the report, including the following: Workbook Settings?

» fonts

» colors

» data

» peer group, and
» time period.
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Using Workbook Settings and Component Settings

What do | need to know before changing a time period?

The time period (Start Date and End Date) is one of the features you can change in
either Workbook Settings or Component Settings. Before selecting a different time

period, you should understand the following:

What do |
need to know before

changing a time period?

» The time period initially used in your report is determined by the settings in the
template (or report) your report is based on.
» You can modify the time period for your report or for individual compaonents, and
» You have two options on how to change the report’s default time period and two
options on how to change a component’s time period.

Changing the time period for a report or a component is summarized in this table:

When changing the time
period for this...
Report

@ Note: Selecting a companent
is optional.

Using Start Date and End Date selections
here...

Command bar > Home tab >
Workbook icon > Workbook Settings:
Data window

Command bar > Chart or Data Table tab >
Application Settings icon (next to the Time
Period drop-down field) >

Default Period

The result is...

The default time period is changed for the
report. All components, both existing and
yet-to-be created, are affected. See
Exercise 13 on page 68.

< Note: Individual components with a
non-default time period are not affected.

A selected chart or table

Command bar > Chart or Data Table tab

The time period is changed for only the
selected component. Other existing
components and new components you
create are not affected. See Exercise 14 on
page 71.

@ Note: The selected component will not be
affected if you change the report’s default
time period.
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Using Workbook Settings and Component Settings

What are the start and end date selections?

The Start and End Dates can be set in Application Settings, Workbook Settings, and

Component Settings.

In the Start Date drop-down field, the selections at the top range from one day to 20
years ago. You can also enter a date. However, the drop-down field also offers flexible
selections for dates associated with specific content or events, such as the following:

investment(s) in the report or component,
benchmark used in the report or component, or

inception date, or

>
>
» return date
>
» when the report is updated.

Start Date

5 Years ago -

[ 12 Tears ago
|- 20 Years ago
Since Inception

Common Inception (Exclude Banchmark)
‘Common Inception (Include Benchmark)
Since Inception (Oldest Shars Claszs)

Common Inception (Cldest Share Class)
First Investment's Inception Date

First Investment's Inception{Oldest Share
Parformance Start Date

‘Common Parformance Start Date
Shortest Tenured Manager Start Data
‘Common Shortest Tenured Manager Start
Longest Tenurad Managar Start Date
Common Longest Tenured Manager Start [E =l
Last Week End ‘

Last Manth End
Last Quarter End |
Last Year End -

In these selections, you
can include or exclude
the benchmark.

These dates are determined by
the report date.

m | 3

< Note: Inany component with start and end dates, when a Common Inception option is
selected as the Start Date, the common inception date is displayed in the legend.

The selections in the End Date drop-down field are event- or time-bound, except for
Common Return End Date (at the bottom of the drop-down field), which is determined

by the investments in the report.

Enter Date =

Last Market Close
Last Market Close (-1 day)}
Last Market Close (-2 days)
[ Lest Week End |

Last Week End (-1 week)

| Last Manth End
Last Quarter End
Last Quarter End (-1 quarter}
Last Quarter End (-2 quarter}
Last Quarter End (-2 quarter}

| Last Year End

| Last Year End (-2 years}

| Last Year End (-3 years}
| Last Year End (-4 years)

| Last Year End (-5 years}
| Last Year End (-5 years}
| Last Year End (-7 years}
| Last Year End (-8 years}
|- Last Year End (-9 years)
| Last Year End (-10 y=ars)
| Last Year End {-15 years)
| Last Year End {-20 years)

Event-bound options

Time-bound options

Time-bound options

Common Return End Dats -

What are the start
and end date selections?

MAORNINGSTAR

Morningstar Direct Cloud Editions October 2018

© 2018 Morningstar. All Rights Reserved.

66



Using Workbook Settings and Component Settings What are the start and end date selections?

Note that some of the selections can be expanded. In the selection shown here, the
end date is three months ago month end:

End Date

Last Month End (-2 months) -
Last Market Close +
Last Markat Clase (-1 day)} =
Last Markat Close (-2 days)
Last Week End
Last Week End (-1 week)
Last Month End
{-1 manth) =| Click the caret to show
(-2 manths) additional selections.

(-4 months)
(-5 months)
(-& months) =
(-7 months)
(-8 months)
(-2 months)
(-10 manths)
{-11 manths)

Last Guarter End

Last Quarter End (-1 quarter}

Last Guarter End (-2 quarter} x

Certain components offer additional date options. See the following:

» How can | compare funds” holdings using their most recent common portfolio date?
on page 146

» How does the portfolio date affect the end date in a stacked bar chart? on
page 148, and

» How does the portfolio date affect the end date in a stacked bar chart? on
page 148.
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Using Workbook Settings and Component Settings Exercise 13: Change the time period for a report

Before starting this exercise, you might want to review What do | need to know before Exercise 13: Change the
changing a time period? on page 65. time period for a report

To modify the time period for a report, do the following:
1. In the ProShares-Vanguard navigation pane, click page 1.

On page 1, in the Investment Growth chart and Performance table, natice that the time
periods match. This time period was initially defined in the template on which the report
is based.

Manager Analysis

Investment Growth
Time Partoc: 5/1/201F to 4/30/2017

150.0
1B2.5
175.0
1E7.5
1g0.0
15Z.5

185.0

137.5 Both components reflect the

S same five-year time period.

132.5

i115.0

107.5
P o
100.0 -
\,.g,f_y_..)"'ﬁ
925

10/2012

iShares Core SEP 500

Performance /

Time Perioc: 57172012 o 43072017 |CHII:JIE'.||:1 ganchm

A=turm

IShar=s Core SEF SO 13 E1

Vanmguard Divicend Apprecliaticn ETF 11.83

Fussell 1000 TR USD 13 &3
Morningstar Direct Cloud Editions October 2018 68

MOHMNGSTAH © 2018 Morningstar. All Rights Reserved.



Using Workbook Settings and Component Settings

Exercise 13: Change the time period for a report

2. Onthe Command bar, select the Home tab, then click the Workbook icon. The
Workbook Settings: Data window opens.

< Note: If you are working in a factsheet, the icon on the Home tab is still labeled Workbook.

3. From the Start Date drop-down field, select an 1 Year ago.
4. From the End Date drop-down field, select Last Quarter End.

L1

When the Workbook
Settings window
first opens, the Data
tab is selected.

5. Click OK. The Workbook Settings window closes. You have changed the default for

the report.

Note the settings
for Start Date and

Home Chart Data Table Format
an ld L3l A = [asl (i 3
Investments | Workbook Page Chart Table Text Image Divide Page  Wiew Calculate Restare
Workbook Settings: Data

Llli] sm] F=F) Ll s | [ [

Datal| | Layout | Style | Peer Group | Attribution | Index Group | Asset Exposure

Time Period

Start Date End Date

|5 Years agoe - || |Last Month End - || Lol
Rolling Window Size Rolling Window Shift End Date.
[B‘fears V] [1 Maonth Vl
Portfolio Data: As-of-date

[Mc-st Recent Portfolio v J,

Data Source

Return Type Return Series

[Tntal Return x | [I‘nh:unthh.r Return X |

Total Return Type Currency

[Pre-tax | [Base |
Risk-free Rate

USTREAS T-Bill Auction Ave 3 Mon Q}J

I:‘ Extended Performance

Require Continuous Source Data

] o]
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Morningstar Direct Cloud Editions October 2018

© 2018 Morningstar. All Rights Reserved.

69



Using Workbook Settings and Component Settings Exercise 13: Change the time period for a report

Note that the time period in both the chart and table on page 1 have changed. This is
true throughout the workbook because each component’s time period is linked to the
report’s default time period.

Manager Analysis

Investment Growth

|_ me= Parloc: 44172016 o 373172017

118.0
116.0
114.0
11%.0

alo.0

Both components reflect
the new default time

~ iShares Core SEF 500

Performance

Time= Perlog: 4172016 o 3 '3'._-']01._-r

IShar=s Con= SBF 500

Vamguard Divic=mnd Appreclation ETF

Russell 100D TR USD

6. Select any component and at the top of the window, select the Chart or Data Table tab.
The information in the Time Period portion of the selected tab tells you the following:

» the start and end dates for the selected component, and
» if the selected component uses the report’s default time period.

a Home Chart Data Table Format
=] Default Pericd - | o |1 Year ago - |4 |Last Quarter End * =4
e e The selected component
Investments | [Time Period Start Date End Dats reflects the report's
T e Tirnn Darind default time period.
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Using Workbook Settings and Component Settings

What are Component Settings?

Component Settings are options specific to a single component These options can
affect various aspects of the report, including the following:

» fonts
» colors
» data
> peer group, and
» time period.
< Note: In Companent Settings, you can change many of the same things you can in Workbook
Settings, but only the selected component is affected.

Before going on to the exercise, you might want to review the information in What do |
need to know before changing a time period? on page 65

Before starting this exercise, you might want to review What do | need to know before
changing a time period? on page 65.

When you modify the settings of an individual component (such as a chart or
table), the new settings override the Application and Workbook Settings, but only for
that component.

To modify the time period of an individual component, do the following:

1. With ProShares-Vanguard open, select the Investment Growth chart at the top of
the first page.

What are
Component Settings?

Exercise 14: Change
the time period
in a component

Investment Growth

I'!'lrre Perind: 4172016 o 3/31/2017

11B.0
116.0

14.0
112.0

110.0

10B.0

106.0

472015 52016 62015 712015 8/2015 9r2016

10,2016

iShares Cor= S&P 500 =—=Vanguard Dividend Appreciation ETF

The time period
reflects the
default.

Morningstar Direct Cloud Editions October 2018
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Using Workbook Settings and Component Settings Exercise 14: Change the time period in a component

2. Onthe Command bar, select the Chart tab.

}IE | Chart |I Data Table Format

[Default Period A | [ o |l Year ago - |_:| ||_35t Quarter End - | | Note that the Time Period
Time Period Start Data End Date displays Default Period.

3. From the Start Date drop-down field, select 6 months ago.
4. From the End Date drop-down field, select Last Month End.

Q Home | Chart |' Data Table Format

R ILnd:.ed - | e |6 Months ago - |:| |Last Quarter End = |:|
Investments | Time Period Enter Date - 1 Enter Date lftLhe repgrtf'mCLjUdeS
. 0 Day ago ]| Beric Last Markst Close %mzr;erﬁogslrnfou
1 Day ago 3 Last Market Close (-1 day) could select one of
2 Days ago I Last Market Close (-2 days “ them from here.
3 Days age Last Week End
1 Week ago Last Week End [-1 week)
— 1 Month ago A
Man 2 Months ago 5 Last Quarter End

3 Months ago Last Quarter End (-1 gquarh

4 Months ago Last Quarter End (-2 quarb

1 1
nves! 5 Mont ago Last Quarter End (-2 gquarh
T P=
— Last Year End
111.0 7 Montl
onths ago Last Year End (-2 years}
110.0 g Months ago —
Last Year End (-3 years)
- 2 Months ago
109, Last Year End (-4 years)
i 10 Months age

Last Year End (-5 years
11 Months age Lo )

|
|
|
|
|
1 Year ago I
|
|
|
|
|
|

107.0 Last Year End {-& years)
|
106.0 Last Year End {-7 years}
|- 2 Years ago e e
1050 | | 3 Years ago st Year End (-8 years)
i0d.0 |+ 4 Years ago Last Year:Encll; 9 years) —
Last Year End {-10 years)
103.0 |- 9 Years ago
Last Year End {-15 years)
102.0 |+ & Years ago -
Last Year End {-20 years)
00 |- 7 Years ago
4 m 3
10000 | ! 8 Years ago = L
T —
gon | 4 [l =

| -
\
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Using Workbook Settings and Component Settings Exercise 14: Change the time period in a component

The new dates affect only the selected component. The other components in the report
are unchanged.

Investment Growth
Time Perfoc: L171/301E to 4/30,/2017

T Time period specific to
o this component

112.0

110.0

oDE.a

105.0

10d.0

102.0

1m0.g -~

1173018 L2 2D1E
= iShares Core SEF 500 = Vanguard Dividen Default time pe”od from
the Warkbaok settings
Performance
Time= Perlod: 44172011 o 3730/2017 | CaloulzBon Banchmarik: Russed 1000 TR USD
|'u' E ot .|E 7
Raturn Sto Dy

|IShares Core SBRP SO0 12.43 11.41
Yanguard DHvlide=nd Apprecladon ETF 173 1045
Russell 1000 TR USD 12.34 11.E4

5. With the Investment Growth chart still selected, select the Home tab, then select the
Chart tab. The information in the Time Period portion of the selected tab tells you
the following:

» the time period for the selected component, and
» if that time period matches the report’s default time period. In this case, the Time
Period indicates “Locked,” which means the component doesn't use the default

time period.
Q Home Chart Data Table Format
] Locked - | e |6 Months ago - |_| |Last Month End | o
Investments || Time Period Start Date End Date Locked is displayed
: - when the selected
Investments Time Period component’s time

period does not match
the report default.
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Using Workbook Settings and Component Settings

What is a linked time period?

6. To save your work, click the Application Settings icon at the top-left corner of the
window and select Save.

ﬁ Home Chart
[New Factshaet Crl+N
Open Crl+0
Savs | Ctrl+5
Be sure to save your work frequently.
Save As

Save zs Templats

Export
Send To »
Shars With ¥

Exit

Initially, a component’s time period is the same as the time period in Workbook
Settings. The component’s time period is linked to the report’s time period. If you
change the report’s time period in Workbook Settings, that change is reflected in the
linked time periods of components.

When you change a component’s time period (as described in Exercise 14: Change
the time period in a component on page /1), the link becomes inactive. An inactive link
is not affected if you change the time period in Workbook Settings.

You have been working with linked time periods in Exercise 13: Change the time period
for a report on page 68 and Exercise 14: Change the time period in a component on
page 71.

What is a
linked time period?

Morningstar Direct Cloud Editions October 2018

MOHMNGSTAH © 2018 Morningstar. All Rights Reserved.

74



Using Workbook Settings and Component Settings Exercise 15: Create multiple time periods

In this exercise, you will create additional time periods, allowing you to change the Exercise 15: Create
time periods for all components and pages in a report without modifying each multiple time periods
component individually. Keep the following in mind when working with multiple

time periods:

» You can create up to eight additional time periods.

» The time periods are available if you need them but are not necessarily in use in
the report at any given time, and

» The time periods are specific to the report (or template) in which they are created.

& Note: When you create time periods as described in this exercise, those time periods are
available in all companents in the report.
To create additional time periods, do the following:

1. In ProShares-Vanguard, click the Home tab, then click Workbeok. The Workbook
Settings Data window opens.

'a Home Chart Data Table Format

e el LY e A -
Investments | Workbook Page Chart Table Text Image

Click Workbook to create a new
workbook from scratch.

Setting Insert

2. Click the Time Periods icon to the right of the End Date drop-down field. The Time
Periods dialog box opens.

Workbook Settings: Data

| L-llj | las 1=FF | e | Ldisl Laiil

Data| | Layout | Style | Peer Group | Attribution | Index Group | Asset Exposure

Time Period
Start Date End Date

|5 Years ago = |Last Manth End = Lo .
Clicking a gear icon opens

Rolling Window Size Ralling Window Shift a related custom Settings
(2 vears ) [z Month =) dialog box or window.
Portfolio Data: As-of-date

| Most Recent Portfolio - |

Data Source

Return Type Return Series

[Tntal Return V] [Mcnnthl\.I Return Vl
Total Return Type Currency

[Pre-tax - [Base |

Rizk-free Rate
USTREAS T-Bill Auction Ave 3 Mon "kl

[] Extended Parformancs
KZI Require Continuous Source Data

| OK || Cancel |
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Using Workbook Settings and Component Settings

Exercise 15: Create multiple time periods

3. From the drop-down fields, select a Start Date and an End Date for at least one

time period.

< Note: If you are building a template, keep in mind that all time periods are enabled, which
means anyone who uses the template can select from all nine time periods. If you want users
to select from specific time periods (for example, the first six), you may want to name the other
time periods “Do Not Use.”

Time Periods

Click a calendar icon to open a
calendar and select a date

Name Start Date End Date
Default Period |5 Years ago b || | |Last Month End b |I_|
Time Period 1 | Last Year End - |l | Last Quarter End bl
Time Period 2 |1 Year ago A |Last Quarter End x|
Time Pericd 3 |8 Years ago - | |Last Quarter End b |
Time Pericd 4 |5 Years ago bl |Last Quarter End x|
Time Period 5 |10 Years ago - | |Last Quarter End - |
Time Period & |15 Years aga bl |Last Quarter End x|
Time Period 7 |20 Years ago x|l |Last Quarter End x|l
Time Pericd 8 |Common Inception Tl |Last Quarter End ot |:

arRlr=y

4. In the Name column, name the time period(s) you changed to indicate its range. For
instance, the name 1YrAgo-LastQtrEnd describes its range.

5. Click OK.

6. Inthe Workbook Settings: Data window, click OK.

You can name any of the time
periods, except the default

MAORNINGSTAR
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Using Workbook Settings and Component Settings Exercise 16: Apply a predefined time period to a chart

When working with a report in which additional time periods have been defined, you Exercise 16: Apply a
can switch from the default time period to one of the predefined time periods for a predefined time period
specific chart. to a chart
Do the following:
1. In ProShares-Vanguard, on page 9, select the Returns-Based Style Allocation chart. On
the Command bar, the Chart tab is now selected.
ﬁ Home Chart Data Table Format % r. H
T e el P The time period of the
Tnvestmants Time Period Chart Ared selected chart is displayed

on the Chart tab.

Holdings-Based Style Trail
Time Period: 7/31/2017 to 6/30/2018

Returns-Based Style Allocation
Time Period: 7/1/2017 to 6/30/2018

100.0 \
® I 00 739 The selected chart displays
& ‘ & L S a blue border.
‘ 10.0 366 g5.8
= B 20.0 TEE 13.2
10.5 s,
i . all ... e
: j
w ‘ Morningstar US LargeMarningstar US LargeMorningstar US Small Morningstar US Small
o al TR USD Growth TR USD val TR USD Growth TR USD
£ . ‘
bty Dasanihat mProShares Largs Cap Core Plus = Vanguard SGF 500 ETF mRuzzell 1000 TR USD
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Using Workbook Settings and Component Settings

Exercise 16: Apply a predefined time period to a chart

2. Onthe Chart tab, from the Time Period drop-down field, select a modified, renamed
time period. The report refreshes to reflect the selected time period in the chart and on
the Chart tab (when the chart is selected).

ar
Investments
Investments

o Home |  Chart

Data Table

Format

Default Period - | |5 ‘Years ago

Default Period

Last¥rEnd-LastQtrEnd
1¥rAgo-LastQtrEnd
FYrshgo-LastQtrEnd
SYrsAgo-LastQtrEnd
10¥rsAgo-LastyrEnd
Inception-LastQtrEnd
Do Mot Use

- |_| |Last Month End

-

|

Start Date

5172011 10 B/31/2016

End Date

Time Period

If you select Locked and
later change the Default
Periad, the locked
component will not change
to the new default.

Numzer af Perods
=a

1l

[ e——

a3 fr i
Sam v iea furr 8=

oyt -y 332 St 7 2T

AME TimoSsuors Smell Cop Growth Imall - TSOIX

Czmtury mmall Czp Soiest 1l

Ock Rifgs Smell Czp Growth &

Touchalons Sroll Cap Gromth ¥
113 Ausmscl 2000 Growth TR LSD

Do Mot Use

120
110
10.0
5.0
B.D
7.0
E.0
50

g an

dap

: 20

Eip n I

Home Chart | Data Table Format X W
1¥rAgo-LastQrEnd v | £ |1 Year ago ¥ |=H |Last Quarter End - |J
pents | [Time Period EStart Date End Date
hents | Time Period
Return Distribution Snapshot
Time Paricc: 7/1/2015 to &/30/2015
b Tadkes "
fiz= mell 2zmaa Small Sz tmadl aze

=T
oA
MEALX

The time period information for
the selected chart is displayed
at the top of the window.

MAORNINGSTAR
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Using Workbook Settings and Component Settings Exercise 17: Reset a chart’s time period to the default

When you created additional time periods in Exercise 15 on page 75, you might have Exercise 17: Reset a
noticed that the default time period was listed in the Time Periods dialog box. It is also chart’s time period
listed on the Time Period drop-down field. These settings make it easy to reset a chart's to the default

time period to the default at any time.

To reset a chart’s time period to the default, do the following:

1. In ProShares-Vanguard, on page 9, select the Returns-Based Style Allocation chart. On
the Command bar, the Chart tab is now selected.

Q Home Chart Data Table Format
=r [1¥rAge-LastQtrEnd v | £ |2 ¥=ar ago ~ | = |Last Quarter End ~ Ch ]
Investments | Time Period Start Date End Dat= Ralling Window Align Th B B
e time period of the

Investments Time Period Chart Area)

selected chart is displayed
on the Chart tab.

Returns-Based Style Allocation
Time Period: 7/1/2017 to 6/30/2018

100.0

72.0
60.0 54.9 541
40.0 4 36.6 o5 g
17.6
i 0.0 0.0 0.0 -
- . |

Morningstar US Large Morningstar US LargeMorningstar US SmallMorningstar US Small

The selected chart displays
a blue border.

Val TR USD Growth TR USD Val TR UsD Growth TR USD
mproShares Large Cap Core Plus Vanguard S&P 500 ETF mRyssell 1000 TR USD
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Using Workbook Settings and Component Settings

How can | learn more about customizing components?

2. Onthe Chart tab, from the Time Period drop-down field, select Default Period. The
report refreshes to reflect the new time period in the chart and on the Chart tab (when
the chart is selected).

o

Time Pericd 1
1¥rAgo-LastQtrEnd
Time Period 2

Home Chart Data Table Format
o |'1‘rrAgo—LastQtrEnd - |{} |1 Year ago ~ | |Last Quarter End > |E [ [m]
Investments | |1¥rAgo-LastQtrEnd » Start Date End Date Rolling Window | Align
e Pl Default Period Time Period Chart Area

If you select Locked
and later change the

Time Pericd 4
Time Period 5
Time Pericd 6
Time Period 7
Time Pericd &
_LEckEd

1sed Style Allocation
'f1/2017 to 6/30/2018

72.0
I 54.9 54.1

80.0
60.0

40.0 32.8

17.6

20.0 10.5

0.0 0.0 0.0

0.0

Val TR USD Growth TR USD Val TR USD

mpProShares Large Cap Core Plus Vanguard S&P 500 ETF

Morningstar US Large Morningstar US Large Morningstar US Small Morningstar US Small
Growth TR USD

mRyssell 1000 TR USD

Default Period, the
locked component
will not change to
the new default.

3.2

8.5

Remember—if you have changed the time period in Workbook Settings, that is the
new default for the component.

In this section, you have learned how to customize the properties of individual
components. As you become more familiar with Presentation Studio, you will see
customizations that are common to most components, such as clicking the Eye icon to
show or hide certain data.

Additionally, in most components, when you click Chart Settings or Table Settings, you
can do the following:

» select a different benchmark
» select a different currency, and
» change, add, and delete data points.

However, some components have uncommon features to help you display additional
information. To learn about these components and their settings, please read Using
Components with Nonstandard Features on page 140.

How can | learn more
about customizing
components?

Morningstar Direct Cloud Editions October 2018
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Creating a New Page Overview

Creating a New Page

You can add a new page anywhere in a report. Overview
This section guides you as you do the following:

» add a page to a report (page 81)

» create a page layout (page 82)

» use Snap to Grid to precisely resize a cell (page 85), and
» insert a component into a cell (page 86).

When you add a page to a report, you can choose to duplicate an existing page or Exercise 18: Create
create a blank page. The new page appears after the page selected in the a new page
Navigation pane.

To add a new blank page to the end of a report, do the following:

1. In the Navigation pane of ProShares-Vanguard, seroll to the bottom and click the last
page to select it.

Manager Analysis

Estimated Net Flow (Month-End)

7.8M

- 1250 GAMCD Sma j-'MIc Cap valu= R
X Aussell 2900 TR USD Drag the scroll bar to move up and
Estimated Net Flow $Mil (Month-End)|  00WN in the Navigation pane.

1m

1250 GAMCD Small/Mic Cap Valus &
1280 GAMCC Small’Mic Cap Valus ©
1250 GAMCD Small/Mig Cap Vaius 1
1250 GAMCD Small/Mig Cap Valus R
1250 Giobal Eguity Managsrs A
1250 Glotal Talents &

Fussell 2000 TR USD

The selected page is outlined in blue.

Seurea: Marningstar Direct
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Creating a New Page Exercise 19: Create the page layout

2. Onthe Command bar, select the Home tab.

3. Click the Page icon and select New. A new page is created after the page selected in
the Navigation pane (in this case, the last page).

Practice Workbook * - Prezentation Studio

B .

Format
1/ TR A - [as)
Investments  Workbook Chart Table Text Image Divide Page  View If you select DUD”CGTE, a copy
Setting \| i | e of the selected page is created.
== Cover 2 K &
= e L Duplicate
= |
_____ Dalete Del

The newly created page consists of one large cell, which is fine if you want to use a

large component or a table component requiring a full page. But in most cases, you
want the page to contain multiple cells.

Exercise 19: Create
the page layout

Do the following:

1. On the Home tab, click the Divide Page icon and select the right Two Cell option.
e m zt Data Table Format : : X mE T
e ] ol Lilw ] lus] | & 1 K
Investments Workbook Page Chart Table Text Image Divide Page View Calculate Restore PDF PRT Xps Excel
Twio Cell Four Cell
Three Cell Five Call The_ Two (_Ie_ll
options divide the
page into two cells
*‘I | of equal width.
Six Cell
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Creating a New Page

Exercise 19: Create the page layout

The page is now divided into two cells.

2. With the top cell selected, on the Home tab, click the Divide Page icon and select the

left Two Cell option.

Note that the top
cell is selected.

Twio Cell

Four Cell

Thraa Cell

Five Call

Six Cell

This option divides the
selected cell into two
side-by-side cells of
equal width.

MAORNINGSTAR
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Creating a New Page Exercise 19: Create the page layout

The top cell is now divided into two cells.

You might need to click each
cell to see the two cells.

Searce: Marningstar Direct

< Note: The cells do not have to remain equal in size. You can resize them as you did earlier in
Resize a cell on page 53.

3. To save your work, click the Application Settings icon at the top-left corner of the
window and select Save.

n Home Chart
New Factshaet Ctrl+N
Open Ctri+0
Save | Ctrl+5
Be sure to save frequently.
Save As

Save as Template

Export

Send To b
Share With »
Exit
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Creating a New Page Exercise 20: Use Snap to Grid to precisely resize a cell

In the blank page, the two cells at the top are the same width (3.75"). However, the Exercise 20: Use Snap
design calls for the left cell to be 2.75". to Grid to precisely resize
acell

You can resize cells by dragging the margin and cell borders, but even with the ruler

and gridlines visible, it can be difficult to set an exact measurement, such as 0.75".
Snap to Grid makes it simple to precisely resize and position cells.

To enable Snap to Grid, do the following:

1.
2.

On the Home tab, click View, then from the menu, select Snap to Grid.

If Ruler is not already selected, select Ruler.

You can also display or hide
the gridlines.

E - |Bll/ul@|&|

= Divida Fie
mbering Columns | Divide Page e

Style Layout Gridlines

@ Ruler

@) Snap to Grid

On the page, hover your cursor over the vertical border between the two top cells. The
cursor changes to a double-sided arrow.

The current position
is displayed just
below the ruler.

Drag the cursor to the left while watching the position numbers displayed just below
the ruler.

When the position number is close to 3.25", release the cursor.

The position number changes
as you move the cursor.

Hover the cursor over the border once more and notice that, even though you may have
released the cursor somewhere between 3.23" or 3.27", the new position is 3.25",

If the position displays a different value (perhaps 3.20 or 3.30),
you released the cursor when it was closer to that position.
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Creating a New Page

Exercise 21: Insert a component into a cell

Inserting a component into a cell is the same process as replacing a component—

drag-and-drop.

Do the following:

1. With ProShares-Vanguard open and the last page displayed, make sure the Home

tab selected.

2. Select Chart > Markets and drag Market Trailing Returns Bar Chart into the empty
cell in the upper-left corner.

Exercise 21: Insert a
component into a cell

PDF PPT X
Note the

a Home Chart Data Table
o -] lilln | A |m] i Ve
Investments  Workbook Page Table Text Divide Page  Wiew Calculate Restore
Setting I Markets ! :
.
1
I i Performance U_/'\/ N
= _&h /“/' gy
= Asset Exposure v - T
o Holdings Analysis Markets Growth Markets Drawdown
E Chart Chart

highlighted
selections.

Markets Trailing

US Broad Market Indexes

220
200
14
1D

10

o

o

o

= 0.0

mStanzard & Foor's
= lishirs S000 Groweh TR USD

2o | | 1 :
.o | | - | 1
. | | [ | 1 l B
o o [ | 1 1
A [ | 1 1
Eza L [ [ | 1 1
V1o 1vear 3 veass 5 vears 10 Years

=NASDAG 100 FR USD

1% ears

D1 Incustrial Average TR USD

The chart occupies
the top-left cell.

Scurce: Morningstar Direct

MAORNINGSTAR
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Creating a New Page Exercise 21: Insert a component into a cell

3. With the Home tab selected, select Table > Performance, then drag Morningstar
Category Ranks into the bottom cell.

Q ' Home | Chart Data Table Format
< N Bl A - [ ) i € :
Investments  Workbook Page Chart |Table| Text Image Divide Page  View Calculats Restore PDF
Setting y out | caleulate | Linking [
] 2 la
o
= e [— 2
Asset Exposure e e e S Note the
M—— e [ —— S
Holdings Analysis e BB e e hlghllghmd
? T am m==: = aa|  selections.
Attribution Single stment  Multiple
Performanc Investment
Snapshot Performance
T — Style Analysis e i
Time Series .:.... T o
fawenn) - -
Asset Flows Multiple Morningstar
Investment Category Ranks
i . Multiple Returns Drawdown

The page should now look like this.

US Broad Market Indexes:
20

200
&80

16D

The page has two

124 | components.
120 |
0.0 !
B0 |
20 |
4o |
£za i
L ; |
b i

1 Vear 3 Years 5 vmars 10 Years 15 Vears

=tancana & Foors =NASDAQ 100 FRUSD D Incustrial Average TR USD
| mfliskir= 5000 Grown TR USD |
Morningstar Category Performance
Tatal - Tatal - Tatal
iz Tatal Rmt 3 o Rt % e Retd:
B Morningstar Ret 1 Rank FRank - Rank
e Category T cat1 naten 2 cat3 Anntz > cats
(Ma-Enz) [Ma-Ene) s ¥ i r i
L {Ma-Enc) - {Mg-Ena) L
PraShares Large Can Core Flus /3172017 US Furd Largs Blang 18.04 20 1008 1 1842 3
Wamguars SEF 500 ETF /3172017 US Furd Largs Blang 17.43 £ 10.10 10 1537 15
Ruszail 1000 TR USD 53172007 - 17.48 - sE3 - 1537 -

Source: Marningstar Direct

< Note: You will Insert an image into the top-right cell in Exercise 27 on page 102.
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Creating a New Page Exercise 21: Insert a component into a cell

4. To save your work, click the Application Settings icon at the top-left corner of the
window and select Save.

ﬁ Home Chart
[New Factshaet Crl+N
Open Crl+0
Savs | Ctrl+5
Be sure to save frequently.
Save As

Save zs Templats

Export

Send To »
Shars With ¥
Exit
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Customizing a Component Overview

Customizing a Component

Each component allows a certain amount of customization. When you modify (or Overview
customize) a setting of an individual component, that setting overrides Application
Settings and Workbook Settings, but for that component only.

You have learned how to modify a component’s start and end dates from the Command
bar (Change the time period in a component on page 71), but many other aspects of a
component’s look and content can be customized by using the Component Settings.

Before starting this section, you might want to review How do Application, Workbook,
and Component Settings relate to each other? on page 20.

This section describes using Component Settings to do the following:

» customize a bar chart by hiding values and changing the orientation (page 89)
» customize a table by changing the portfolio date and removing a row (page 92)
» add a data point to a table component (page 94), and
» change a data point in a table component (page 96).

A chart is a graphic representation of data. You have seen how you can modify that Exercise 22: Customize
representation by resizing a chart to make it more readable or make the page more a bar chart
presentable. You have modified the represented time period to focus on specific

data. Color, marker shapes, and line widths are some of the other graphic properties

you can use to enhance a chart. These and other options are found in the

Component Settings.

Do the following:

1. In ProShares-Vanguard, go to page 10.

2. Select the Multiple Investment Sector Exposure chart.
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Customizing a Component

Exercise 22: Customize a bar chart

3. At the bottom of the window, click Chart Settings. The Chart Settings window opens.

Manager Analysis

Lh R

20,0

[Multiple Investment Sector Exposure Chart

Notice the values above
each of the vertical bars.

15.0 14.3

Basic Materizls %

15.6 138 15.5
12.8
11.9
11.2
10.0 94 g
7.6

Lo 5.0
3, . |

3.3

b | 3.2

. i . I - .

1.0

Consumer Cydical % Financizl Services % Real Estate %

Consumer Defensive Healthcy
%

The Component Settings button
displays “Chart Settings” or “Table
Settings,” depending on the type of
component you have selected.

4.

:Proshares Large Cap Core Plus 4/30/2017 Vanguard S&P 500 ETF

ance Y

Chart Settings &

R E LT

In the Chart Settings window, next to Values, click the Eye icon.

< Note: The various chart types have different options in the Chart Settings window.

| Chart Settings

Display |

| Base

I Vertical Bar

Multiple Investment Sector Exposure Chart

|Se|ect from Morningstar Database -

[ 1]

If the Chart Settings window obscures
your view of the chart, drag here to
move the window, but do not click the X.

=)

Investments
ProShares Large Cap Core Plus
Vanguard S&P 500 ETF

Russell 1000 TR USD

Maost Recent Portfalio

The Eye icon is available in many settings,
- allowing you to display or hide a variety
of features.

Available Portfolios

MAORNINGSTAR
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Customizing a Component Exercise 22: Customize a bar chart

In the chart, the numbers above each bar are no longer displayed.

Multiple Investment Sector Exposure Chart
22.5

20.0

i7.5

The new setting takes
effect immediately; the

Component Settings
12.5 window does not have
buttons for Apply or OK.
10.0
7.
5.
0.0

15.0

wm

(=1

]

Basic Materials %  Consumer Cydical % Financial Services % Real Estate % Consumer Defensive Healthcars %
%%

5. In the Chart Settings window, from the Orientation drop-down field, select
Horizontal Bar.

Chart Settings m

Multiple Investment Sector Exposura C

The default orientation for
this chart is vertical bar.

Vartical Bar

Most Recent Portfolic v

Investments Available Portfolios
ProSharas Large Cap Core Plus
“anguard S&P 500 ETF

Russell 1000 TR USD

Morningstar Direct Cloud Editions October 2018 N
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Customizing a Component Exercise 23: Customize a table

The chart now looks like this.

Multiple Investment Sector Exposure Chart

mm ProShares Large Cap Core Plus
Vanguard S&P 500 ETF

== Russell 1000 TR USD

Basic Materials %

Consumer Cyclical %

If the space
available and/or
number of
investments make
the selected
orientation
unappealing,
simply select the
Vertical option.

Financial Services %

Real Estate %

Consumer Defensive %
Healthcare %

Utilities %o

Communication Services %
Energy %

Industrials %

[Technology %

0.0 2.0 4.0 6.0 8.0 10.0 12.0 14.0 16.0 18.0 20.0 22.0
6. To close the Chart Settings window, do one of the following:
» In the upper-right corner of the Chart Settings window, click the X, or
» Click away from the Chart Settings window.
Customizing a table is similar to customizing a chart, however a table offers Exercise 23: Customize
different options. a table

Do the following:
1. In ProShares-Vanguard, on page 10, select the Equity Sectors table.

<« Note: The funds do not report portfolio numbers on the same date, which is why the dates in
the Portfolio Date column do not match.

2. At the bottom of the window, click the Table Settings button. The Table Settings
window opens.

Equity Sectors

LA B e > |[D * |[E »* |[E -
Portfolid Basic Consumer Financial Real Note the portfolio
Dat= Materials %5 Cwclical % Services % Estate % dates do not match
ProShares Large Cap Core Plus |4/30/2017 3.53 14.29 15.61 5.02
vanguard S&P 500 ETF 4/30/2017 2.50 11.17 15.83 2.32
Russell 1000 TR USD 5/31/2017 3.11 11.328 15.50 3.22

The Component Settings
button now displays
“Table Settings.”

Table Ssitings & 4ﬁﬁ@5ﬂﬂ§[ﬂ][ﬁliﬁﬂ!ﬂ J
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Customizing a Component Exercise 23: Customize a table

3. From the Portfolio Date drop-down field, select Last Year End.

Table Settings IE‘

| Ta || Columns || Rows |

Equity Sectors Er \
Note that you can hide the

BASE b Table Title and Portfolio Date.

L~
Most Recent Portfolic 4 Er

Enter Date

Investments Most Recent Portfolio

Most Recent Common Portfolio
ProShares Large Cap Cors gjdast Available Portfolio

T nn eTe | L@st Month End
Vanguard SER SO0 ETE. | ik stk Eii 1 il

Russell 1000 TR USD Last Quarter End

The default Portfolio Date for this
table is Most Recent Portfolio.

Available Portfolics

< Note: You might need to move the Table Settings window to see the Equity Sectors table.

Note the following changes to the table:
» The data shown in the columns now reflect the portfolio date you selected.
» The Portfolio Date is now displayed above the table, and
» The Portfolio Date column has been removed.

Equity Sectors
Portfolio Date: 12,/31/2016

Basic Consumer Fimancial Real Consumer
Materials % | Cyclical % | Services %  Estate % | Defensive % :
The new portfolio
ProShares Large Cap Core Plus 3.47 12,44 15.22 4.21 9,21 date affected several
features in the table.
Vanguard S&P 500 ETF 2.68 10.97 16.21 2,33 5,49

Russell 1000 TR USD 3.02 11.62 16.10 3.37 8.51

4. To save your work, click the Application Settings icon at the top-left corner of the
window and select Save.

n | Home Chart
News Factshaet Ctrl+N
Open Ctrl+0
Save | Ctrl+S
Be sure to save frequently.
Save As

Save as Template

Export

Send To b
Share With »
Exit

Morningstar Direct Cloud Editions October 2018
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Customizing a Component

Exercise 24: Add a data point to a table

In a table or chart, you can add, remove, or replace data points. In this exercise, you

will do the following:

» add a page

» insert a table component, and
» add a data point to the table.

Exercise 24: Add a

data point to a table

< Note: You may want to review Exercise 18: Create a new page on page 81, Exercise 19: Create
the page layout on page 82, and Exercise 21: Insert a component into a cell on page 86.

Do the following:

1. In ProShares-Vanguard, create a new page at the end of the report.

2. Select a three-cell page layout as shown here.

o m Chart Data Table Format % MW K @ |Feedback
4P (] Ly [=a) ] € 4
Investments  Waorkbook Page Chart Table Text Image Divide Page] View Calculate Restore PDF  PPT XPS  Excel
Setting Insert
Two Cell Four Cell
Note the
Threa Cell Five Call h|gh||gh'[ed
selections.
Six Cell
3. Inthe top cell, insert a Multiple Investment Snapshot table.
] m Chart Data Table Format ¥ W R @ |Fed
P b - EE| A = [==) @ 7] X
Investments Workbook Page Chart |Table] Text Image Divide Page  View Calculate Restore PDF PPT XPS Excel
Satting Markets out Calculate | Linking Export
¢ & 2 & 7 -1 &l 10
% Performance
Asset Exposure
Holdings Analysis NOtE the
S Attribution highlighted
selections.
Snapshot
[
Style Analysis
2
Tima Series
Asset Flows Single Investm: | Multiple Single Investrv Multiple
Snapshot Investment Dperations Investment
3 Multiple Returns Snapshot Operations

MAORNINGSTAR
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Customizing a Component Exercise 24: Add a data point to a table

4. In the table, right-click the Inception Date column header, and from the drop-down
field, select Insert Column.

& Note: When you click or right-click a column header, drop-down fields appear above each

column.
Snapshot
& B - |IC * D - _E - .F -
s Marmingstas ol Incepti Brozc
Ticks Catezary Ratind) B === Right-click in
SroShares Large Cap Cors Flus (w1 US Func Largs Sianz ——w— Cut Eculty thIS area...
Vvanguarc S&F 500 ETF Voo US Func Large Blang - Equity
z S = Copy
Russell 1000 TR USD = Large Blenc b Equity
Delete
Select
Transpose
Insert Column
|—|| ; ...then select
S —— Insert Column.
Data Settings
A new column appears to the right of the Inception Date column. It is currently labeled
Morningstar Rating Qverall.
Morningstar Direct Cloud Editions October 2018 95
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Customizing a Component

Exercise 25: Change a data paint

As you saw in the previous exercise, when you create a new column, it defaults to
Morningstar Rating Overall. In this exercise, you will select a different data point for
that column.

< Note: This procedure can be used for any column. It is not restricted to columns you create.

Do the following:

1. If the drop-down field is not visible above the column heading Marningstar Rating
Overall, click the column heading.

< Note: When you click or right-click a column header, drop-down fields appear above each
column.

2. Click the drop-down field above the column header (Morningstar Rating Overall). The
drop-down field opens.

Exercise 25: Change a
data point

Global Broad Category Group

Global Category

Maorningstar Category

Morningstar Institutional Category
Global Investment Fund Sector (GIFS)
Investment Area

Morningstar Rating Overall

US Category Group

Domicile

Region of Sale

CiomA | nmal Cheartoen

| Add || Close |

Snapshot
la 2 s - - ; - |
i Click here to
Morningstar = .
Ticker bormingst=" |Open End Funds | selectadifferent
= data point for
ProShares Large Cap Core Plus CSM US Fund Large Blend |Genera| | thlS C%lumn
Wanguard S&2 500 ETF VoD US Fund Large Bland  Find By Contzins ’
Russell 1000 TR USD g Large Blend
|Snapshot v|
Name N
Base Currency ( ]
Virtual Class =
Ticksr
ISIN

The options in this drop-down field are similar to those you see throughout Morningstar

Direct, whenever you search for a data point to use. You can select from the following
fields to find the data point you want:

» Universe (Open End Funds in the above illustration)

» Location (General in the above illustration), and

» Find By (View or Contains).

When Find By View is selected (as in the above illustration), the data points found in
the selected View (Snapshot in the above illustration) are displayed.

When Find By Contains is selected, the View drop-down field is replaced by a
Search field.

MAORNINGSTAR
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Customizing a Component Exercise 25: Change a data point

3. Inthe list of data points, select Investment Area, click Add, then click Close.

B ~|IE - |E |
|0pen End Funds —|
| General v|
Find By @) View () Contains
|Snapsh0t v|
Name i
Base Currency [’)
Virtual Class I
Ticker

ISIN

Global Broad Category Group

Global Category

Morningstar Category

Morningstar Institutional Category
002 Oyesimern g =T

|Investment Area

Morningstar Rating Owverall

US CAteoary Grotp Select this data paint.
Domicile
Region of Sals 3
Ciamd | amal Cheamben A
| add | | Close

4. The column header now reads Investment Area and the column displays
that information.

Snapshot
- 5 S el =l
Ticker M&?g;r:ﬂfar ;nr:?m"t Note the highlighted selections.
“roShares Large Cap Core Plus CSM US Fund Largs Blend —
Wanguard S&P 500 ETF WOoo US Fund Largs Blend| United States of America|
Russell 1000 TR USD = Largs Blend| United States of America|
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Working with Headers, Footers, Images, and Watermarks

Overview

Working with Headers, Footers, Images, and Watermarks

Images can be an important part of your presentation. For instance, a company logo
reinforces your company’s branding. Many graphic formats, such as .jpg, .png, and so
on, are compatible with Presentation Studio.

A header is an area for information at the top of a page (company name, logo, and so

on) and a footer is displayed at the bottom of a page (page number, source of data, and
so on). In Presentation Studio, a report can have the same header and footer on every
page, or individual pages can vary.

This section describes how to do the following:

understand what content to include in a header or footer (page 98)
add a header (page 100)

insert an image into the header (page 102)

change the position of an image (page 104)

understand what dynamic text is (page 105)

use dynamic text in the header (page 105)

change font properties (page 106)

use the same header on every page of a report (page 107)

change the size of an image in a body cell (page 109), and

add a watermark (page 113).

vV V vV vV VY VY VY VY

< Note: In this section, working with a header is described. The process for creating and
working with a footer is the same.

Header and footer content does not have any hard-and-fast rules (although your firm'’s
legal and design teams might). Some common elements used in header and footers are
as follows:

» Your company logo
» Your company name
» Client name

» Report type

» Report date, and

» Page number.

The information in a header and/or footer can apply to the entire report or selected
pages. Some common header and footer page layouts are as follows:

» The same header and footer are displayed on every page.

» All pages have the same header and none have a footer, and

» The header and/or footer content on pages 2 to the end differs from that on the
first page.

Overview

What content
should | include
in a header and footer?

Morningstar Direct Cloud Editions October 2018
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Working with Headers, Footers, Images, and Watermarks

What content should | include in a header and footer?

In the illustrations here, note the headers and footers, where they match on both

pages, and where they differ.

Multi-Manager Attribution Analysis

WOLRCCHA MY

Multiple Investment Attribution Total

Time Perloc: /172017 to 57312017

Calculaticn Allpcaticn Setecticn Active S=nchmark
Banchmark Effect Effect Retum FReturm
ISharss Edgs MSCI Min Val USA Fussell 1000 TR USD -o.z8 1.53 127 z.41
wanEck Vectors Memingstar Wide Moat ETF Russ=ll 1000 TR USD 0.01 0.13 .13 241
SPOR® SSEA US Large Cap Low Valatll ETF Fussell 1000 TR USD .73 .S L%+ 241
Attribution Summary Scatter Plot - Attribution Summary Scatter Plot
Time Perioc: 37172017 to 573172017 iTime Pertod: 3/1/2017 to 573172017
z.a0 3.00
180 2.50 Y <
120 .00
o.20 4 150
0.40 P oon
iE
” ia
] ]
£ oan P& n.so
o L -
[ a
-] ‘E
i Eg
© -0.40 i § 0.op
" 0.50 -0.70 0.50 0.30 0.10 a.10:" .00 100 00 ER ] a.00 5.00
Aliacation Efect i Fortfalio Asturn
T T am Bk e Saee maCas 2 el BT 4 IITAE FATD X Laegm Can e e G ETmmuE zge MEIT Wm0 URa ¥ VarEcc Vectorm Mormingter Wiz Moat 5T 4 EFORT EGA LS avge Caz Low Vol §TF

On the first page,
the header
displays the type
of report and a
company logo.

The first page
does not have
a footer.

Multi-Manager Attribution Analysis

page, the header

header on page 1.

The second page

which the page
number and page
count are displayed.

On the second
SEURLCRIPARY
Allocation Effects Allocation Effects matches the
Time Perioc: 3/1/2017 ko 573172017 Time Feriod: 3{1/2017 ta 5/31/2017
[PRmT— cutpastarm unzarpartrm P
00 g :
: ) . i
[ t £ |2 t i
§ z |5 z
& H
150 .60 6
e
0
o 0
O (4]
o.ao e | poo -
£ £
H o
] i
L & £
= z
Q
-3 0.50
e
=-3.00 + 1.20 +
-12.510.00 -T.58 -5.00 -250 0O 250 500 750 10.001Z.50 -12.50.00 -7.50 -5.00 -2.50 000 250 500 750 10001250
Ralmtten Rt Raltive Gatam
am gy S wgeeg Waigrt - et i vagereg :
has a footer in
Cznaumer Cyzhz Tezhnziegy mnzrgy
re— S2e 0 med mams mal mwecs 555 € Commams Sysiel =
Cemmuniesban Scrvcsa oo "ranccl Scressa Coraumsr Defonaive o.== 1.z |5} Heoltfzarc LA -
Hzzithears =R=1 Conaurmer Ooficnans o Molorish 0.12 1,88 Pnencizl Szrvicsm -a. o.eg
inuatriste S cie -imam 0926 Lele 231 23G9 0 Comeunesiomsvems  Dar GEL D
Page 2 of 6

MAORNINGSTAR

Morningstar Direct Cloud Editions October 2018
© 2018 Morningstar. All Rights Reserved.

99



Working with Headers, Footers, Images, and Watermarks Exercise 26: Add a header to a page

The page you created in ProShares-Vanguard currently has no header, but the other Exercise 26: Add
pages do. In this exercise, as you add a header to the page, keep in mind that you can a header to a page
add a header and footer to any page, or replace components in any existing header

and footer.

To add a header, do the following.

1. With ProShares-Vanguard open, in the Navigation pane, scroll to the bottom and select
the last page. (This is the page you created in Creating a New Page on page 81).

US Broad Market Indexes
220

200
1.0

1D

120
120

w0

In the Navigation
pane, the selected
page is outlined

\Shares Core Z8E 530 £/30/2017 US Funz Large Sienz 17.2¢ 3= 10.42 in blue

Wanguard Dividend Appredation ETE 4/30/2017 US Fund Largs Blend 1538 se a7
Russell 1000 TR USD 4/30,2017 — 103 — 10.20

2.
- - - = TR [=
Header| Footer Text Image Align Bullets Numbering
|Insert Healierl E
) e g 4
The other selections on the Header menu become available
orkbook after you have inserted a header.

13 P; 1

il

I} Tarr _:I-!lr:!!‘.-1
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Working with Headers, Footers, Images, and Watermarks Exercise 26: Add a header to a page

A new cell opens at the top of the page.

To make room for the header,
space was removed from the
two rows of cells.
TS Eroad-Market
20
200 |
8.0 |
B.D |
140 B
120 1
oo | | | | | -
za B |
50 | |
40 | 1
Ezan
Bog L | L g
Yo 1 Year 3 Years 5 Years 10 Years 15 Years
mStandard B Poor's =NASDAQ 100 PR USD D Ingustrial Average TR USD
= Wiishire S000 Growth TR USD
Morningstar Category Performance
Tatal e Total Tatal
— Total Rt % i At el Rt s
-BH‘! Momingstar Ret 1 Rank -\HniDC-3 fdl‘f Annizg E- Rank
I n Category hid Cat 1 Catz Cats
gieena {Mo-Ena] r i " T r
tMa-zna) A (Ma-Ena) e £ Me-End)
PraShares Largs Cap Core Plus 17 US Fund Lange Bieng 1E.08 Fal 1004 11 16.48 3
Vanguarc S&F 500 ETF US Fund Large Blenc 17.43 31 1010 pi-} 15.37 15
Ruszsil 1000 TR USD - 17.48 - 9.83 - 15.37 —

3. With the header cell selected, on the Command bar, make sure the Fermat tab is still
selected, then click the Divide Page icon and select the Twe Cell option showing
side-by-side cells.

¢ I.Inrne d!a.rt " !Jila Tal?!e | Format | .
. = A nd B B B Verdana ~ (10 ~| 8|l ][u][a][&] Ea Wlth two cells
in the header,

Header Footer Text 1Image | Align Bullets MNumbering Columns ||/ Divide Pagel] view
you can have

Two Cell two components
in the header.

Insert Style

P

4. Inthe header, allocate more space to the left cell and less space to the right. Select the
left cell and drag its right border to the 6.5" mark on the ruler (approximately).

You can use the

ruler as a guide
when you move
a border.
=
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Working with Headers, Footers, Images, and Watermarks

Exercise 27: Add an image

5. To save your work, click the Application Settings icon at the top-left corner of the
window and select Save.

Q‘ Home Chart
[New Factshaet Crl+N
Qpen Ctrl+0
Savs | Ctrl+5
Be sure to save frequently.
Save As

Save zs Templats

Export

Send To »
Shars With ¥
Exit

In this exercise, you should use an image available on your network or drive.
< Note: Although the logo is being added to the header, the process described here can be used
to add an image to any cell.
To add a logo, do the following:
1. In ProShares-Vanguard, in the header, select the right cell.

2. Onthe Command bar, select the Format tab, then click Image > Insert Image. The Open
dialog box opens.

ﬁ Home Chart

[, = A =
Header Footer Text | Image Align Bullets Numbering

Insert | Insart Image |

I-:- = i - Report Portal Image E
oL
—

Exercise 27: Add
an image

Note the highlighted selections.

Morningstar Direct Cloud Editions October 2018
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Working with Headers, Footers, Images, and Watermarks

Exercise 27: Add an image

3. Inthe Open dialog box, navigate to a loca
an image file.

tion on your network or drive and double-click

[ €Open - ——

—_ﬂ

@uv| .« Training Guides PC.CL » Logos

- | 3 | | Search Logos yel |

Organize » New folder

¢ MSMFVOLZ (\WMSFSB0T) (G:) = Mame

-

¥ MSMFVOL2 (\WMSFS80T7) (H:)

I S XYZ_Wealth_Advisors_Logo.jpg

L MSMFVOL3 (\\MSFS807) (1)

L MSMFVOL3 (\WMSFS807) ():)

% MSMFVOL3 (\MSFS807) (K:)

g VOUL (\vmorningstar.com\5She
s MSPUBIVOL2 (\\MSFS80T) (T:
g VOU (\vmorningstar.com\She
@ pchrist (\\morningstar.com\SIl_

m

?ﬂ Network

File name: X¥Z_Wealth_Adviso

il | 2

rs_Logojpg  * ’Imageﬁles(*,bmp,*.jpg,*.png,*. v]

[ open || cance |

The image is displayed in the header cell.

Double-click here
to insert this image.

XYZ

WEALTH ADVISORS

By default, the
image is centered
in the cell.

MAORNINGSTAR
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Working with Headers, Footers, Images, and Watermarks

Exercise 28: Ch

ange the position of an image

When you insert an image, it is centered in the cell.

To change the image's position, do the following:

1. Select the cell containing the image.

Exercise 28: Change the
position of an image

2. Onthe Command bar, select the Format tab, then click Align > Right.

Q Home
T = A
Header  Footer  Text
Insert

Chart

Image

Data Table

I Format |

(@]

Align

k=l [=

Bullets Mumbering

Laft

¥ W E [

Middle

Right

Justified

Top

XYZ

WEALTH ADVISORS

You can select one option
from each section of the Align
menu; the top four selections
position the component
horizontally, and the bottom
three selections position it
vertically.

Middle

Bottom

The image aligns with the right side of the header cell.
The size of the
XYZ image does
WEALTH ADVISORS not change.
3. To save your work, click the Application Settings icon at the top-left corner of the
window and select Save.
n !. Home | Chart
[New Factshaet Crl+N
Open Crl+0
Save | Ctrl+5
Be sure to save frequently.
Save As
Save a5 Templats
Export
Send To N
Share With oy
Exit
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Working with Headers, Footers, Images, and Watermarks

What is dynamic text?

Dynamic text displays information (such as investment name, ticker, and so on) specific
to a report or investment. Dynamic text updates automatically whenever the report is
opened or refreshed. For instance, if a report displays the dynamic text component
Report Date, the new report date is displayed when you open the report.

< Note: If you do not want to keep the updated Report Date, close the report without saving.

In this exercise, use the dynamic text component “Workbook Name” in a header. The
header then reflects the name of the report.

@ Note: You can type text in a cell but it won't be dynamic.

Do the following:
1. In ProShares-Vanguard, in the last page's header, select the left cell.

< Note: Because a cell cannot accommodate more than one component, the text and image
must be in separate cells.

2. Onthe Command bar, select the Format tab, then click Text > Dynamic Text >
Workbook Name.

ﬂ‘ Chart : Data Table Format

- = YA| = B = = =

Header Footer |Text| Image Align Bullets Numbering

What is dynamic text?

Exercise 29: Use dynamic

text in a header

Inss BiAnchmark Description . Style
Cust Text B &
Dynamic Text 3 ProShares Large Cap Core Plus
ETF Research v Vanguard S&P 500 ETF
Global Fund Repe Russell 1000 TR USD
Investment Strateg ¥
Manager Biography , Investment Mame
Us e
224 Manager MNarratives Ticker
TEE Morningstar Commenta » Name & Ticker Note the
: . highlighted
1: Note y Display Benchmark 1 e ey
il Principal Risk o Display Benchmark 2
10.9 )
oa Report Portal Text y Calculation Benchmark 1
iy - Calculation Benchmark 2
4.0
E E 2 Category Average
s 0o
Yo 1 Year 3 Years 5 Yeams 1 CI.IITEI'ICV
mStanzars & Focr's «NASDAT 100 PR LISD Return Date
mWiishir 5000 Grewen TR USDH
Morningstar Category Performance Portfolio Date
Time Period
Relg;;: i As of Date
Mo-Eng =
Report Date
SraShares Large Cap Corz Flus Sf312017 US Fund Lasgs Waorkbook Name
vanguars SEF 500 ETF 5 17 US Funa Langs
Aussail 1000 TR USD sr3y7017 Page Name
Page #
Page ¥ of ¥
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Working with Headers, Footers, Images, and Watermarks Exercise 30: Change font properties

The workbook name is displayed in the header.

HP'\:Sha res-Vanguard |

XYZ

WEALTH ADVISORS

U5 Broad Market Indexes

20

200 Il
1E.0 | | I

The text defaults
to left and top
alignment; the
font and font size
match the report
font defaults.

You can change font properties of a text component (whether dynamic or not) from the Exercise 30: Change
Command bar. Some of the font properties are as follows: font properties

» Font family (Times Roman, Helvetica, and so on)
» Font size, and
» Font style (bold, italic, and underlining).

Do the following

1. In ProShares-Vanguard, with the Format tab and the left header cell selected, from the
Font Size drop-down field, select 24.

Format

E Verd. ~|liz ~|B -

(= I ik | ] L2 ” ql You can also select a different

mbaring & font family and apply bold, italic,
Style 8 or underlining.

=
Mw H
i1

The header should now look something like this.

ProShares-Vanguard

XYZ

WEALTH ADVISORSY

Your header
displays the image
you selected.

Morningstar Direct Cloud Editions October 2018
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Working with Headers, Footers, Images, and Watermarks Exercise 31: Use the same header throughout the report

2. To save your work, click the Application Settings icon at the top-left corner of the
window and select Save.

0 Home Chart
[New Factshaet Crl+N
Qpen Ctrl+0
Savs | Ctrl+5
Be sure to save frequently.
Save As

Save zs Templats

Export

Send To »

Share With >

Exit
You do not have to recreate the header on every page; you can easily share it across all Exercise 31: Use
pages in the report. the same header

Do the following:

1. In ProShares-Vanguard, in the Navigation pane, click a few pages to view them. Note
that, except for the page you created, they all display the original header from the
template.

throughout the report

Manager Analysis MmHNlNGgmH

2. Goto the last page (the page you created) and select a cell in the header.

This is the header from
the Equity Manager
Analysis template.

Morningstar Direct Cloud Editions October 2018
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Working with Headers, Footers, Images, and Watermarks Exercise 31: Use the same header throughout the report

3. Onthe Command bar, select the Format tab, then click Header > Apply Header
to Workbook.

= [ Feadbach .
% R @ [Fee Be sure a cell in the header

you want to use on all
pages is selected.

Header] Footer Text Image Align Bullets Numbering

Insert Header

Apply Header to Workbook

Apply Header & Footer to Workbook

Dalete from Page

Delete from Workbook

ﬁ:\f‘f% ADVISORS
Background Color / Image »
Border Type »
Baorder Style »
Barder Caolor »

4. In the Navigation pane, click a few pages to view them. Now they all display the header
you built.

ProShares-Vanguard ;
XYZ When applied to the Workbook,

WEALTH ADVISOR the header does not change
from page to page.

Multiple Investment Sector Exposure Chart
=2

=0
172
120
122
100
Sontstznda % S Dyt sl S Al Bte h Cemmamar Seforans nesiemns wtine Tetnclogy %
———
== ProShares Large Cap Core Plus. 5/31/2017 Vanguard S&P 500 ETF 4/30/2017 wmRus==ll 1000 TR USD 5/31/2017
Equity Sectors
Partfoilo Date: 12/31/2018
Bazic Cansumer | Financial Rzl Comeumes e sioes | o Comnicaton o s i e
Matzriziz % | Cydical % | Services St | Estete % | Defengivese oo o WHIHESSE 1 paryicag g, EREraY S Incustrials S Tecinalaoy %
FroSnares Large Cap Core Pius 247 1248 1522 231 521 1258 455 EET 743 10.48
vanguars SEF 500 ETF 288 10.57 1621 z.33 243 1378 317 a3 7.8 1103
Fuszzil 1000 TR USD 202 162 16.10 3.37 Es1 FERE] 308 407 731 1148
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Working with Headers, Footers, Images, and Watermarks Exercise 32: Change the size of an image

5. To save your work, click the Application Settings icon at the top-left corner of the
window and select Save.

Q Home Chart
[New Factshaet Crl+N
Qpen Ctrl+0
Savs | Ctrl+5
Be sure to save frequently.
Save As

Save zs Templats

Export
Send To »
Share With »
Exit
When working with an image, keep the following in mind: Exercise 32: Change

» When you insert an image into a header or footer cell, it resizes to fit the cell the size of an image

without distorting the proportions; and
» \When you insert an image into a regular (body) cell, it does not resize to fit the cell,
which means it might be too large or small for the selected cell.

In this exercise, inserting an image into a body cell and changing its size is described.
Do the following:

1. In ProShares-Vanguard, on the last page in the top row, select the right (empty) cell.

2. Onthe Command bar, select the Fermat tab, then click Image > Insert Image. The Open
dialog box opens.

B Home

[ =
Header Footer Text |[Image Align Bullets MNumbering

Insert | | Insert Image |

e

Note the highlighted selections.

Report Portal Image

—

1
=H
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Working with Headers, Footers, Images, and Watermarks

Exercise 32: Change the size of an image

3. Navigate to a location on your network or drive, and double-click an image file. The
image is inserted into the selected cell. The cell remains selected.

WEALTH ADVISORS

€ Ceen — A —
-
@U" |« COVE.. » Logos & WebEx Banners » - | 5f| | Search Logos & WebEx
Organize « New folder ez
2 Marme : Da *
1% Computer & Wach Uninepng 7
I & Local Disk () 5 MLOGO_Logo_red.gif 971
Ca# MSMFVOL2 (\\MSFS80T) (G2) < MLOGO Logo.redjpg o/
g MSMFVOL2 (VWMSFSE0T) (H:) | & Money.png 577
St MSMEVOL3 (\WMSFS807) (k) S Place your lege herejpg 5
L MSMFVOLS (WMSFSE07) () < Pres Studio_Mstar.png 12,
The selected image appears in the cell.
XYZ

o Total hiirsa: Total

Tatal

The image is centered in the
cell and does not change size.

Double-click an
image file to insert it
into the selected cell.

R:;:}: Rt Fh:'_r“i Res R:::'c

ERat '1c -1\'|r.'.'\:‘.3r l;:t: Annizd & Ezt :

yr r ¥r

[Ma-Enc) [pe-End) [Mo-Enz) Mo} IMa-Ena)

a0 10.04 11 16.48 3

3l 10.10 10 15.37 15

T 9.83 fo- 15.37 -
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Working with Headers, Footers, Images, and Watermarks Exercise 32: Change the size of an image

4. With the right cell still selected, right-click and select Position > Fit.

Note the highlighted selections.

(7] oo

Show Margin
Stretch

Background Calor »

When resized proportionally,
the image might not fill the cell.

Morningstar Direct Cloud Editions October 2018 m
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Working with Headers, Footers, Images, and Watermarks Exercise 32: Change the size of an image

5. With the cell still selected, right-click and select Position > Stretch.

[ — - -

Show Margin

Note the highlighted selections.

Background Color

Border Type »
Baorder Style »

Baorder Color »

Save to My Components

The image resizes to fill the cell, but loses its original proportions.

= — =
]

Note the distartion in the image.
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Working with Headers, Footers, Images, and Watermarks

Exercise 33: Add a watermark to a report

6. To save your work, click the Application Settings icon at the top-left corner of the

window and select Save.

Save zs Templats

Export

Send To

Shars With

Exit

ﬁ Home Chart
[New Factshaet Crl+N
Open Crl+0
Eail Ctrl+5
Save As

Be sure to save frequently.

You can add a watermark to a report. The watermark appears in the PDF generated
from the report. This feature is useful when a report has restricted distribution, such as

“Internal Only.”

To add a watermark, do the following:

1. Inareport, select the Home tab, then click Workbook. The Workbook Settings

window opens.
2. Select the Layout tab.

3. Click the Display Watermark in PDF checkbox.
4. In the text field to the right of the checkbox, type the watermark text.

< Note: The maximum number of characters is 50, including spaces.

Exercise 33: Add
a watermark to a report

MAORNINGSTAR
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Working with Headers, Footers, Images, and Watermarks

Exercise 33: Add a watermark to a report

5. (Optional) From the drop-down field to the right of the text field, select a color.

Show "Source: Morningstar Direct” at page bottom

[] Show contant of "Multiple” data points

¢ ] Home | Chart Data Table Format
W e LY e A = (B (i )
Investments  |Workbook Page Chart Table Text Image Divide Page  View Calculats Restore PDF PPT X
Setti Workbook Settings: Layout
[BH) l=a] 25| [ - Ludill Lidl
| bata | |Layeou Style | Peer Group | Attribution | Index Group | Asset Exposure
;_— Overall Workbook
= - ~E| Font Font Color Page Calor Report Languags
- =
£| |Morningstar 1 il [_ v] [ lFuIIow User Praference
Margins
Top Bottom Left Right
|o,5in &2 |o.4in s |o,4in & |o4m }i{

Display Watermark in PDF for Intarnal Use Only

I |

Component Title Settings
Font Size Font Color

12 = Blz]le] (- -

Bar Style

Background Caolor

) (—

These settings control the text
and color of the watermark

Text Component Settings

Fant Size

iz

Table Row Spacing

Font Color

>] [ — ]

Table Component Settings

MNull Value Display Mode

Zero Value Display Mode

[consi White Space At Bottom

[ Dash

[Zero

0Odd Row Color

Even Row Colar

( =) (B 1~

H Cancel |

6. Click OK. The watermark text is not displayed in the report.

7. At the top of the window, on the Home tab, click PDF. The PDF menu opens. Select an

output option. In this example, Full Report is selected.

|[7 ECNTX Factsheet * - Presentation Studio

o

¢ Home

Chart Data Table Format ¥ [} _back
I : ; Select any
a8 [ LS il E A =) (i option on the
Investments Workbook | Page Chart Table Text Image | Divide Page \View | Calculate | Restore PET  XPS Excel drop'dOWn field
Setting Insert Layout Calculate Linking | Full Report |

Selected Page(s)

Selected Component

Fidelity® Contrafund® Return Date: 7/31/2017

Portfolio Date: 6/30/2017

FCNTX

Compulggo }

MAORNINGSTAR
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Working with Headers, Footers, Images, and Watermarks Exercise 33: Add a watermark to a report

When the PDF has finished generating, it opens.

([ File Edit View Window Help

Home Tools FCNTX Factsheet-1... X - N Q)

B X Q ) |1 /1 R M e v e

Fidelity® Contrafund® Return Date: 7/31/2017 CUI'Il'IpﬂI'Iy }

FCNTX Portfolio Date: £/30/2017 Logo
Rolative to Posr Group Fidality® Contrafund® - Risk
Peer Groug (5-35% Fends - LS. - Large Growth Time Perios: 812012 7312017
W Top Cusrsle W Znd Quartie WSS 3rd Qusrtie NN Bottom Quartie Caicutation Benchmari: Fuzssl 1000 Growth TR USD
= e Bkl
=
i Retum IS 1580
] _ S Dey ™ e
iy T — Swarme fatin 147 149
2 e e Sertng Fase % |
Fidelity® Coreshund® a2 EE 3 3 85 s 1636 BestOuarier AL
‘Suzzal 1000 Gowth TR USD me e B LS =1} LT p— 47 zm o
2 Farcain ET wIE £T 158 amn 1= \ sz s I The watermark text is
2 e W m um sE w . — displayed on every page
504 Parcantin "z L 4% e 3as7 1558 ) 238 I
754 Parcantin. asT 15 B3 i 1336 [ 1 a7
354 Parcantin. 1040 a3 1M 41 F T 2
St Dev &z BSE

\ Loos S Dev m =38

Leading Cantributers it

‘Time Pefiodt 51,2017 to 7312417

\ Longest Up Sea o} T 7
frcan 232
» 2 o T <
Faceboni B & S \’ s L u
e

e smpny e )
ackisien Bizant e Q’ [+ i
Lengest Cwn ezt 3 3
Amazn.cemin AT \' B iz el
e Ren Down% A 7
Berkstive Hatroway iz & ] [E2}
Start Oate 130/2015 12/2015
Nestia ke 1 1535 [E]
Ena e £t G
Citges e T8 0%
3 Mzs Drawdown [a) 7
Usiseskesits razp e e [E]
Max Drawdown % -an 240
s com = L5
Feai Date 812075 B/2S
nc T 228 oz
Ve T E IS
VimBctas A =] EES oz fl
_— w55
Trailing Raturns. Time Ferios: §1/2012 10 731207
TO T manth 3 montes 6 masthe 1 yesr 2 yesrs 3 yesrs & years 5 years 10 yesrs e Bl
Rieeftyl® Cortrafurd ® M= 354 EE 1885 IO T0SZ 1237 1356 1535 %90 EwessReum 235 [
Rl DOEWNTRUSD 172 28 GE 1371 1805 1059 1286 14 1580 33 AR L) oo
Betz s 100
[ = 000
Tracking Emar 2z 200
Intareatios R foed) Az =
Treynar Batio igen) 1588 1537
Up Cature Fatic 5505 10000
Down Casture Fatia e 10000
Un Numer Ratio s 120
Down Humser Rata 58 100
Up Pescert Rzt LE] n0
Down Percent Azt (%5 [T |
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Creating a Template

Overview

Creating a Template

Up to this point, you have worked with Morningstar templates, but they are not your
only options. You can also create your own templates.

In this section, the basics of creating a template are described as follows:

» what is involved in creating a template (page 116)
» how to save a report as a template (page 118), and
» how to create a portfolio template (page 121).

To create a template, first identify the purpose of the template and then create a report
to present the appropriate data. Once you are satisfied with the report, you save it as
a template.

You can also create a template starting from an empty file or, if you have an existing
template or report with similarities to the template you want to build (in content and/or
layout), you might want to base the new report on that.

In this guide, most of the tasks necessary for building a template have been covered. If
you have followed the steps, you have completed the tasks described in the table here.

Task

Created a report based on an existing template

Click to review the topic

Working with a Template on page 25

Replaced, removed, rearranged, deleted, and
resized components

Working with Chart and Table
Components on page 42

Set a time period for the report

Using Workbook Settings and Component
Settings on page 64

Created a new page with a custom layout and
inserted components in cells

Creating a New Page on page 81

Customized individual components using Chart
and Table Settings

Working with Chart and Table
Components on page 42

Added a header and inserted an image and
dynamic text

Working with Headers, Footers, Images,
and Watermarks on page 98

Overview

What is involved in
creating a template?

MAORNINGSTAR
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Creating a Template What is involved in creating a template?

Before saving a report (such as ProShares-Vanguard) as a template, you should do
the following:

1. (Optional) Insert a footer. Consider including dynamic text, such as a page number and
your firm name.

< Note: The steps for creating a footer are the same as those for creating a header. See Add
a header to a page on page 100 and in steps 2 and 3, click the Footer icon and select
Insert Footer.

2. Review the content on all pages to make sure the purpose of the template is supported
throughout the report. Some of the questions you should ask yourself include
the following:

» |s every component relevant to the purpose of the template?

» |s the order and position of components appropriate to the purpose of the template?

» Are similar components (such as a chart and a table displaying holdings-based data)
displayed on the same page?

» s every page easy to read?

» Are text, table, and chart components easy to interpret?

» Are more pages needed?

» Can you delete any pages?

» Where can you use dynamic text to make the template as flexible as possible? For
instance, if regular (typed) text is used, it is shown in every report based on the
template, so make sure you have not keyed in the names of the firm, benchmarks,
indexes, and so on

» |s every component and page appropriately labeled? For instance, if every
component on a page displays information about risk, it might not be necessary to
show the label (or title) of every component.

» Does the report meet your firm's branding and design standards? You might want
to contact your Marketing or Design department to learn about preferred fonts
and colors.

< Note: Do not assume a Morningstar template can be used without modification. If you need a
template for Current Portfolio Analysis, the Morningstar Current Portfolio Analysis template is
a good starting point, but do not skip the above review steps. At the least, you should remove
or replace the Morningstar logo.

When creating a template, one thing you do not have to modify is the investment(s)
you selected. The investment(s) are simply placeholders so you have a visual
representation of your work. When you save the report as a template, the investments
and related data related become irrelevant.

When you want to use a template as the basis of a new report, you open the template
and you are immediately prompted to select investments. (See Select an investment on
page 29 and Select investments from a saved list on page 37.) The sample investments
in the report are replaced by the investments you selected and the report accesses the
data related to the selected investments.

Morningstar Direct Cloud Editions October 2018
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Creating a Template Exercise 34: Save a report as a template

When you are satisfied that your report is as template-ready as possible, save it as Exercise 34: Save a
a template. report as a template

@ Note: In this exercise, it is assumed that your ProShares-Vanguard is final, regardless of what
condition itis in.
Do the following:

1. With ProShares-Vanguard open, in the upper-left corner of the window, click the
Application Settings icon and select Save.

E Home Chart
Mew Fackshast Ctrl+M
Open Ctrl+0
Save | Ctrl+5
Saving the report ensures its
Save As current condition is saved when

you save it as a template.
Save a5 Template

Export

Send To .
Share With .
Exit

2. Click the Application Settings icon again, and select Save As Template. A dialog

box opens.

E Home Chart
ﬁew Factshaet . Ctrl+M
Open Ctrl+0
Save Ctrl+5
Save As
Save a5 Template |

Saving the report as a template

Export creates a new file; the report is
not affected.
Send To b
Shara With '
Exit
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Creating a Template Exercise 34: Save a report as a template

3. Inthe Template Name field, replace “ProShares-Vanguard” with Manager
Analysis - Equity.

Presentation Studio E

Template Name Manager Analysis - Equity

Saved Templates

p=t
Name

= My Templates 4

I The template is saved into
the My Templates folder.

|5a1re Hgam:\el‘

4. Click Save. An alert opens, reporting that the file has been successfully saved as
a template.

5. Close the template. The Presentation Studio Home page is displayed.
6. On the Presentation Studio Home page, on the toggle, select My Templates.

MOORNINGSTAR Presentation Studio

: | Search Name

Workbook + Factsheet + Plan Review
) Click here to access
your templates.
'ﬁ: Marningstar Templates My Templates MyReports ) | Action ¥ ) [ New Folder )
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Creating a Template What do | need to know before creating a portfolio template?

Your templates are displayed in the list area.

Marningstar Templates My Templates My Reports ) Action v ) | New Folder )
Name " '_urlpE
2 Portfolios Comparizon Workboaok Template
Current versus Proposed Portfolio Comparison Workboaok Template
Current vs Proposed Portfolio Workboaok Template
Custom Workbook Sample Workboaok Template
Equity Manager Analysis Workboaok Template
Investment Detail Workbook Workbook Template | Your new template s displayed
at the bottom of the list.

Investment Performance Factsheet Factsheet Template

(| Manager Analysis - Equity ] Workbook Template

The two portfolio templates are as follows: What do | need to

know before creating

» Portfolio Proposal template, and a portfolio template?

» Portfolios Comparison template.

In these templates, the features you have learned about (components, page layouts,
headers and footers, and so on) are available, but they are not prebuilt in the
templates. To create a portfolio template, you must build from scratch.

Do the following:

1. On the Presentation Studio home page, click the Portfolios tile. The Choose Template
dialog box opens.

2. Click New Template. The Select a Template Type dialog box opens,

Choose Template )
New Template Click here to begin.

Templata Nama Owner Type
When you have created a
portfolio templates, its
name, owner, and template
type are displayed here. It
can then be used as the
basis for a portfolio report.
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Creating a Template Exercise 35: Create a Portfolio Proposal template

3. Select a template type, as follows:

» Use the Portfolio Proposal template to present a proposed portfolio to a client. Go
to Exercise 35 on page 121.

» Use the Portfolios Comparison template, to compare multiple model portfolios. Go
to Exercise on page 122.

Select a Template Type (Back ) (RS X

These templates contain

@ Portfolio Proposal template SOl (OB M2 e
to portfolios.

' Partfolios Comparison template

After completing the steps in What do | need to know before creating a portfolio template? Exercise 35: Create a
on page 120, do the following: Portfolio Proposal
1. Inthe Add Sample Portfolios dialog box, select the following: template

» aclient account, and
» one or more proposals.

The other fields in the dialog box are optional.

Add Sample Portfolios . 3a|:<-.:" m

Name Display Name Color Marker Show

Client Account

K. Tucker Account - K. Tucker Account [ B e - A client account and
at least one proposal
Performance Benchmarks are required.
Morningstar Mad Tgt Risk TR USD Morningstar Mod Tgt Risk TR USD (—-) (W
@) Proposals
Conservative . Conservative [ < [ A~
™ ( - - O
__._ Display Benchmarks
Marningstar Category Index Marningstar Category Index (— - |
Best Fit Index Best Fit Index (-] (> -
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Creating a Template

Exercise 36: Create a Portfolios Comparison template

2. Click Done.

A blank Presentation Studio file opens.

The charts available in this template are as follows:

» Multiple Investment Growth

» Legend

» Returns Correlation Matrix

» Calendar Returns Bar Chart

» Rolling Window Chart

» Trailing Returns Bar Chart

» X/Y Scatter Plot

» Pie Chart

» Morningstar Style Box, and

» Multiple Sector Exposure Chart.

The tables available in this template are as follows:

» Multiple Investment Performance
» Multiple Investment Snapshot

» Multiple Investment Calendar Returns
» Multiple Investment Trailing Returns, and

v

Portfolio Holdings.

Continue creating the template, using the processes in this document and following
the guidelines in What is involved in creating a template? on page 116.

After completing the steps in What do | need to know before creating a portfolio template?

on page 120, do the following:

1. In the Add Portfolios dialog box, select two or more portfolios to compare.

./l l\.
| Cancel |
hS rd

Add Portfolios
MName Identifier Typs
Aggressive 50058416 Model Portfolio
Conservative 500568418 Model Partfolio 0
Jamison Proposal 00043462 Model Portfalio
Moderate Aggressive Modsl 50058415 Model Portfalio

Exercise 36: Create a
Portfolios Comparison
template

When you select a portfolio, a

checkmark is shown to its right.

2. Click Done. The Add Sample Portfolios dialog box opens.

MAORNINGSTAR
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Creating a Template

Exercise 36: Create a Portfolios Comparison template

3. Selections in this dialog box are optional. Click Done.

Add Sample Portfolios

-+ [

Portfolio
Mame Display Mame

i Moderate Conservative Model ~ Moderate Conservative Model

# Moderate Model Woderate Model

You can
change the
Benchmark hlghllghted
selections
Inception Date Calor Marker ~ Show  Name
alal (-] (@ -]  @®)|Marmingstar Mod Tgt Risk TR USC
7/31/2005 =) (M=) @ |Moringstar Mod Tqt Risk TR USC

A blank Presentation Studio file opens.

The charts available in this template are as follows:

Multiple Investment Growth
Legend

Returns Correlation Matrix
Calendar Returns Bar Chart
Rolling Window Chart

Trailing Returns Bar Chart

X/Y Scatter Plot

Pie Chart

Morningstar Style Box, and
Multiple Sector Exposure Chart.

The tables available in this template are as follows:

>

>

>

>

v

Multiple Investment Performance
Multiple Investment Snapshot

Multiple Investment Calendar Returns
Multiple Investment Trailing Returns, and
Portfolio Holdings.

Continue creating the template, using the processes in this document and following
the guidelines in What is involved in creating a template? on page 116.

MAORNINGSTAR
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Publishing a Presentation Studio Template Overview

Publishing a Presentation Studio Template

You can publish a your Presentation Studio templates and use them when generating Overview
reports in the following Morningstar products:

» Morningstar Direct Cloud Editions, and
» Report Portal.

The requirements for publishing a Presentation Studio template are as follows:

1. You must be the owner of the template.

2. You cannot publish a Morningstar template. However, you can publish a template that
you built based on a Morningstar template (or a template owned by someone else). See
Exercise 38 on page 127.

3. You need permission to publish a Presentation Studio template. If you cannot complete
the steps in Exercise 37 on page 125, contact your Customer Success Manager.

When you publish a template, you decide who may use the template. Be sure to
include yourself (or a group of which you are a member) among those the template is
published to.

In this section, you will learn how to do the following:

» publish a Presentation Studio template (page 125)
» save a copy of a Presentation Studio template you do not own (page 127), and
» use a Presentation Studio template to generate a report (page 128).
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Publishing a Presentation Studio Template Exercise 37: Publish a Presentation Studio template

Presentation Studio initially includes templates from Morningstar, which cannot be Exercise 37: Publish
published to other users. Templates you create can be published to yourself, selected a Presentation
users, or all users at your firm. Do the following: Studio template

1. On the Morningstar Presentation Studio Home page, click My Templates.

MOORNINGSTAR Presentation Studio

'/-. y o, Mo \
| Q. Search Name )

©

Asset
Allocation =

Workbook + B Factsheet e Plan Review +
S S Click here to access
your templates.

e

: Marningstar Templates My Templates My Reports ) '\ Action ¥ /J '\ New Folder ) '\ New Page /'

O Name Type v Layout Version
(O 2 Portfolios Comparison Workbook Template [ Landscape 3.19.18
(O Current versus Proposed Portfolio Comparison Workbook Template [Y Landscape 3.19.16

2. Hover the cursor over the row displaying the name of the template you want to publish.
The Action icon is displayed.

3. Click the Action icon and from the Action menu, select Publish To.

< Note: If Publish To is not an option on the Action menu, you do not have permission to publish
templates. Contact your Customer Success Manager.

MOR

-~ ) e U
{_ Marningstar Templates My Templates MyReports ) (_Action ¥ ) { New Fal

) Name Type

) Equity Manager Analysis Woarkbook Template

) Investment Detail Workf o :
oW Al E_ Action Note the highlighted selections.
) Manager Analysis - Equ

() Portfalio Comparison _

UBS OE/ETF Rank Testl'_

() Pat Cover

Open

Rename

Portfolio Review Cover || Delete

() Custom Investment Perd
| Save As

Investment Performanc
(O Morningstar Quant Rat Send To

Share With

Publish To |
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Publishing a Presentation Studio Template Exercise 37: Publish a Presentation Studio template

4. Click in the Search for User or Group field. A list of your firm's Presentation Studio users
is displayed. Do one or more of the following:

» Enter your email and select it (recommended).

» Search for the emails of the users who should have access to this template; be sure
to select them.

» Select users from the list, and/or

» Click All Firm Users to publish the template firm-wide.
Publish Cancel '
Template Name

Investment Performance Factshest

Investment Range (Min/Max] Sample Report (Optional)
1 to |1 ( Upload PDF )
Access List
Click in this field to make the
(caneel ) (0K ) Individual Users list appear.
Name Email
ALL
=
All Firm Users

INDIVIDUAL USERS
u@morningstar.com

08031 1g@morningstar.com

11 n.cen@morningstar.com

5. Click OK, then click Done. An alert opens.
6. Click OK.

7. Inthe list of your templates, note the template(s) you have published.

Marn ngstar Templates . My Templates ] My Reports ) Action . New Folder New :535-
Nams Type Layout Published |» ”
— You might need to
E I 5 . ; scroll right to see the
Custom Investment Performance Factsheet Factsheet Template |1 Partrait Yes Published column.
Equity Manager Analysis Workbook Template [% Landscape | Yes
Investment Detail Workbook Workbook Template [ Landscape | Yes
2 Portfolios Comparison Workbook Template [4 Landscape | No
Current versus Proposed Portfolio Comparison Workbook Template [ Landscape | _No

In Morningstar Report Portal, you can use your published templates to create reports.
To learn about using Report Portal, read the Morningstar Report Portal User Guide.
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Exercise 38: Create a copy of a template owned by Morningstar

Publishing a Presentation Studio Template or another user
If you built a template based on a Morningstar template or one built by another user, Exercise 38: Create a
when you saved it, you became the owner. If you need to publish a Morningstar copy of a template
template or one built by another user, simply save a copy of it. You do not have to make owned by Morningstar
any changes to the original template to own a copy. or another user

& Note: Morningstar or the other individual is still the owner of the original.

Do the following:
1. Open a template you do not own.
2. Optional: Customize the template.

3. At the top-left corner of the window, click the Application Settings icon and from
the menu, select Save As Template. A dialog box opens.

@ Home Chart

MNew Factshaat Ctrl+N

Open Ctrl+0
Save Ctrl+5
Save Az

Save gs Template | . .
Note the highlighted selections.

Export

Send To .

Share With »

Exit

4. In the Name field, type a name, then click Save.

A copy of the template is created as a new template (with the name you entered).

The original template is unchanged. The template you saved is stored in the My
Templates folder and listed on the Presentation Studio Home Page when My Templates
is selected on the toggle.

5. Publish your template, as directed in Exercise 37 on page 125.
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Publishing a Presentation Studio Template

Exercise 39: Use your template to generate a report

In this exercise, reports for multiple investments are generated, but you can use this
process to generate a report for a single investment as well. Note that you are limited

to 50 investments.

To generate a workbook report for multiple investments, do the following:

1. Launch your Morningstar Direct Cloud edition.

2. Open a list or screen of investments in the Grid View.

Exercise 39: Use
your template
to generate a report

3. Select more than one investment (but not more than 50) by clicking the checkboxes at

the left of their rows.

4. On the toolbar above the grid, click the Actions icon. The Actions menu opens.

5. From the Actions menu, select Generate Workbook Report. The Report Options

window opens.

< Note: If you are generating a workbook report for a single investment, click the Actions menu

on the investment's row.

Eg. An|

Grid View v Performance Analyst Research

02 2017 Gold-Rated Large...

Actions (" 3 “Jl

Add to List

-] Name

Remowve from List

El 1 American Funds AMC]
2 American Funds Ame
®| 2 American Funds Fund
4 American Funds New
5 American Funds Was

6 AMG Yacktman |

R s
odVe A5 NEw LIST

Generate Warkbook Repart |

6. From the Template Type menu, select a template.

< Note: You cannot change the investment range or the Report Name.

Note the highlighted selections.

Report Options (Step 1 of 2) _.:c’ce Next
Eelect template and name regort
Template Type Investment Range
Investment Detail Warkboak v 1-50
Report Name
American Funds New Economy A-Investment Detail Workbook-03232018

7. Click Next. Another Report Options window opens.

If your published templates do
not appear on this menu,
refresh your browser.

MAORNINGSTAR
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Publishing a Presentation Studio Template

Exercise 39: Use your template to generate a report

8. If you have more than 50 investments displayed, remove some of them. Hover the
cursor over one or more of the investments. An X appears to the right.

9. Click the X to remove that investment from the report.

10. From the Time Period menus, select a Start Date, End Date, and Portfolio Date.

Report Specifications (Step 2 of 2) Back Run
Choose between 1 and 50 investments to run this report

Q, Type to search investments

B rican Funds New Economy A

i rican Funds Fundamental Invs A

§ American Funds AMCAP A
3/50 Clear All

A factsheet offers different

e options than those shown here.
Start Date End Date

5 Years Ago W Last Maonth End W
Portfolio Date

Most Recent Portfalio W

11. Click Run. The window closes and an alert opens, informing you that the reports are

being generated.

12. On the toolbar above the grid, a number appears on the Generated Reports icon
when the report is ready. Click the Generated Reports icon. The Generated Reports

dialog box opens.

02 2017 Gold-Rated Large...

o’

(73]

|. W

B[V

Click here to access your reparts.

a Name Ticker  Secld
¥

B 1 American Funds AMCAP A AMCFX FOUSH

Z American Funds American Mutual A AME... FOUSH

B 3 American Funds Fundamental Invs A ANCFEX FOUSH

@ 4 American Funds Mew Economy A ANEFX  FOUSH

5 American Funds Washington Mutual A AWSHX FOUSY

MAORNINGSTAR
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Publishing a Presentation Studio Template

Exercise 39: Use your template to generate a report

13. Click the name of the report.

Generated Reports

Status
Completed

Name
American Funds New Economy A-Investment

Detail Workbook-03232018

Previous reports will also be
listed in this dialog box.

14. Depending on your browser settings, you might be prompted to epen or save the report,
or it might open in a separate browser tab or window.

Keep in mind that reports are not saved indefinitely in Morningstar Direct Cloud; the
Generated Reports list is cleared when you log out of your session. When you log in, you
will not be able to access your reports.

If you elect to open the report or the report opened after generating, it is recommended
that you save it to your system so you can access it later.

< Note: The report is a PDF.

MAORNINGSTAR
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Creating a Batch Report Overview

Creating a Batch Report

Suppose you need a monthly report on certain investments on the 16th day of the Overview
month. Every month, you could create each individual report by doing the following:

1. Open a template.

2. Select the investment(s) to be reflected in the report.

3. Save the report.

4. Repeat steps 1-3 for each investment or set of investments.

It is more efficient to have it created automatically every month at a specific date and
time. The automated process is called a batch report.

< Note: Batch reporting is not automatically enabled in user accounts. To gain access to batch
reporting, contact your Customer Service Consultant.

In the Morningstar Report Portal, you can use your published templates to create
reports. To learn about using Report Portal, read the Morningstar Report Portal
User Guide.

In this section, the following procedures are described:

» understanding the process for generating reports in a batch (page 131)
» creating a batch report (page 132)

» testing a batch report (page 136), and

» download all reports from a batch (page 138).

The overall process of creating a batch report is as follows: What is the process
for generating

1. Select a template. .
P reports in a batch?

2. Select an investment or set of investments for each individual report.
3. Schedule the batch to run.
4. Test the batch.

The advantage to this over creating individual reports every month is that you don't
have to repeat this process.

In these exercises, the procedure to create a batch report for multiple investments is
described, but you can also create a batch to generate a single report on a set
of investments.

< Note: When preparing to create a batch report, keep in mind that a single-investment
template can cover only one investment. In this guide, you used a single-investment template
to create a factsheet. A multiple-investment template covers (and frequently compares)
multiple investments. You used a multiple-investment template to create a workbook.
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Creating a Batch Report

Exercise 40: Create a batch

In this exercise, create a batch to generate monthly ETF Analysis reports for

several ETFs.

Exercise 40: Create
a batch

< Note: If you don't have an investment list or saved search of ETFs, use another investment

type and an appropriate template.

Do the following:

1. On the Presentation Studio Home page, click Batch Management. The Batch Reporting

window opens.

1[4 Presentation Studio

Q Search Name

MORNINGSTAR Presentation Studio

Workbook

Allocation ot

Click here to
create a new
batch or manage

Batch an existing one.

Portfolio Management (&

2. Select the Batch Management tab and click New Batch. The New Batch Setup dialog

box opens.

Batch Management  Batch Reports

Batch Reporting

Action All v Run Now Schedule Template Mapping Refresh
"] Batch Mame Type Last Run Time Next Run Time Status mgtﬁlighheted
[J1 | Batch 1222 Factsheet 12/22/2016 2:01 pm Mot Scheduled (] selections.
[z Mew Factsheet Batch Factsheet 12/22/2016 1:57 pm Mot Scheduled (v}
3. Select Factsheet and click Continue. The New Batch Setup dialog box opens.
New Batch Setup a
|-'!- Factsheet |
You can use only one report type
' Workbook (Factsheet, Workbook, and so on)
: when creating a batch.
' Paortfolio Book
' Retirement Plan
' Sawved Report
—
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Creating a Batch Report

Exercise 40: Create a batch

4. Select Use a single template and click Continue. The Factsheet - New Batch Setup
dialog box opens.

New Batch Setup

| = Use a single template |

Use multiple templates

Continue Cancel

The template you select is used
for every report in the batch.

5. Do the following:

» In the Batch Name field, enter Monthly ETF Analysis, and
» From the Template drop-down field, click Morningstar Templates, then scroll
down and select Morningstar ETF Analysis.

+ Add

Template

Batch Name

Factsheet - New Batch Setup

Mew Factsheet Batch

Mormingstar ETF Analysis l

TSI G oF

Name

Holdings Based Style Consistency
Investment Detail Report

Investment Performance Factsheet

List/Search |Select list/search.

r:stment Display Benchmark 1

You do not have to use a
Morningstar template to
create a batch.

Momingstar ETF Analysis

Mormingstar Sustainability Manager Reseal

Portfolio Aggregation

Single Manager Attnbution 3
Single Manager Attnbution 4
Stock Analysis

My Templates

m

6. Inthe List/Search drop-down field, expand Lists and select a list of ETFs (in this case,
5% Lg Blend ETF US).

Factsheet - New Batch Setup

Batch Name  New Factsheet Batch List/Search | Select list/search...
. ) Select list/search...
Template Morningstar ETF Analysis v =
[ Lists
12 Open End<
+ Add - Delete Ea -~ o b S ek Vit
core Top Bgttom Lis
Name CustomN:'l:r\lf:stment Display Benchm

2015 Top Bottom $core Small Growth

2015CloudListe
2017-5investmentfe
3investments

|5‘= Lg Blend ETF US |

ABC Funde

You can
select any
of your lists
or searches.

| »

s

When you use an investment list in setting up a batch report, the reports respond
dynamically to changes to the list. In other words, when you make changes to the
investment list, the changes are reflected in the reports the next time the batch runs.

MAORNINGSTAR
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Creating a Batch Report

Exercise 40: Create a batch

In the New Batch Setup dialog box, the contents of that list (nine ETF funds) are

displayed in the list area.

Factsheet - New Batch Setup
| Batch Name Mew Factsheet Batch List/Search 5+ Lg Blend ETF US
Template Morningstar ETF Analysis v
+ Add - Delete E -~ e =

Ll Name CustomN::r\lf:stment Display Benchmark 1 BE{I:'I
EFl1 iI5hares Edge MSCI Min Vol USA O | Select Custom Mame... ¥  Primary Prospectus Benc v 0 Select (
[z iShares Edge MSCI USA Size FacQ, | Select Custom Mame... ¥ Primary Prospectus Benc.¥.Q| Select ( %%tgstzz;!ng
3 iShares Morningstar Large-Cap O, | Select Custom Mame... ¥  Primary Prospectus Benc. w0, Select ( the topic of a
a ProShares Large Cap Core Plus O | Select Custom Mame... ¥ Primary Prospectus Benc.w. Q| Select ( separate report.
s ProShares S&P 500 Dividend Ar:Qy, | Select Custom Mame... ¥ Primary Prospectus Benc. ¥ O, Select
|:|6 SPDRE SS5GA US Large Cap Low(Q, | Select Custom Mame... b, Primary Prospectus Benc ¥ O Select (
Elz WanEck Vectors Mormingstar WidQ, | Select Custom Mame... ¥  Primary Prospectus Benc ¥ O, Select
s Wanguard S&P 500 ETF Q, | Select Custom Name... ¥ Primary Prospectus Benc.¥.Q| Select (
s WisdomTree US Quality Dividenc, | Select Custom Mame... ¥  Primary Prospectus Benc v 0 Select (

7. At the bottom of the dialog box, click Schedule. The Schedule dialog box opens.
8. From the Start Time drop-down field, select 07:00.

< Note: The Start Time drop-down field uses a 24-hour clock, so 07:00 is 7:00 a.m. and 14:00
is 2:00 p.m. The clock conforms to your local time.

9. Under Recurrence, click the Repeat on the __ day of every month button, then from
the drop-down field, select 16.

Schedule

Start Time 07:00 hd

Recurrence

|5/12/2017

Every

()
Repeat on the
I’-‘I

First

s

¥ Mon v
¥ day of every month

¥ Mon hd

0K

Month

w

Cancel

The report is to run at 7:00 a.m.
on the 16th day of each month.

MAORNINGSTAR
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Creating a Batch Report

Exercise 40: Create a batch

The Schedule dialog box offers flexible scheduling options to meet a variety of needs.
The first menu in the Repeat on the area usually displays only the options First, Second,
Third, Fourth, and Last. But when you select Day from the second menu, the additional
options Fifth, Sixth, Seventh, Eighth, Ninth, and Tenth become available. In the image
here, the batch is being scheduled to run on the seventh day of every other month.

Schedule
Start Time |07:00 -
Recurrence
P
o/
& Every » | Mon v
(_} 16 L 4
(®) Repest on the Second | w. | Day w of every | Other Mon w
FLE = | | Mon Month
Sixth
e Tue Other Month
'__ Wed OK Quarter 3]
Eighth ‘E Thu
Ninth P
Sat
Sun

Select this option first

|Da-,r |

10. Click OK. The Schedule dialog box closes.
11. In the Factsheet - New Batch Setup dialog box, click Save.

Monthly ETF Analysis is now listed in the Batch Reporting window.

Batch Reporting

Batch Reports

Action = All v
O Batch Name

0
[]2 | Batch1222

s Mew Factsheet Batch

Run MNow Schedule New Batch Template Mapping Refresh NOtE_the next
run time.
Type Last Run Time Next Run Time Status
Factsheet |6f15f201.? 7:00 am |
Factsheet 12/22/2016 2:01 pm Mot Scheduled (v]
Factsheet 12/22/2016 1:57 pm Mot Scheduled [v]

The batch runs on the date and time listed in the Next Run Time column. When the run
is completed, an email is sent to the person who created the batch.

MAORNINGSTAR
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Creating a Batch Report

Exercise 41: Test a batch

Although the batch is not scheduled for an immediate run, you can test it by doing

the following:

1. In the Batch Reporting window, select the Batch Management tab, then select
Monthly ETF Analysis by clicking the checkbox at the beginning of its row.

2. Click Run Now.

Batch Repol
Batch Management Batch Reports
Action - all v | Run Mow | Schedule New Batch .
Running the
O Batch Name Type Last Run Time batch now does
= not affect the
1 Monthly ETF Analysis Factsheet scheduled
[12 | Batch 1222 Factsheet 12/22/2016 2:01 pm batch run.
Flz2 MNew Factsheet Batch Factshest 12/22/2016 1:57 pm

< Note: The number and complexity of reports being generated affect the amount of time to

complete the run.

When the batch is finished running, a green checkmark appears in the Status column.

Batch Reports

Batch Management

Batch Reporting

Action - All k4 Run Now Schedule New Batch Template Mapping Refresh
|l Batch Name Type Last Run Time Mext Run Time tatus
[]1 | Monthly ETF Analysis Factsheet 5/25/2017 4:43 pm 6/16/2017 7:00 am
|l Batch 1222 Factsheet 12/22/2016 2:01 pm Not Scheduled []

K3 New Factsheet Batch Factsheet 12/22/2016 1:57 pm Not Scheduled [v]

3. Select the Batch Reports tab, then select the Factsheet tab and click Monthly ETF
Analysis. The view updates to display the list of batch runs for Monthly ETF Analysis.

Batch Management

Factsheet

Retirement Plan

Browse By_#atch

Monthly ETF Analysis |
Batch 1222
Mew Factsheet Batch

Batch Reports

Workbook  Saved Reports Note the highlighted selections.

-
Last Run Time

5/25/2017 4:43 pm
12/22/2016 2:01 pm
12/22/2016 1:57 pm

Exercise 41: Test a batch

The Last Run
Time is just a
few minutes ago

MAORNINGSTAR
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Creating a Batch Report

Exercise 41: Test a batch

4.

In the window, all runs of the batch Monthly ETF Analysis are listed, including old
batches. Click the Run Date link for the batch you want to view. Because this is the first
time the batch has been run, only one link is shown.

< Note: Batch output is saved in the Morningstar system for two years. At the end of that time,
Morningstar sends an email advising you of the upcoming expiration so you can save the
output locally.

The view updates to display the list of reports generated in the batch run.

Batch Management | Batch Reports

Batch = Monthly ETF Analysis
Retirement Plan Factsheet  Workbook = Saved Reporis

Note the batch
contains nine reports.
Run Date # of Reports Download

| /16/2018 7:00am | 9 i

All reports (including outdated reports) generated from the batch run are displayed. The
file name of each report includes the following:

» Name

» Template name

» Ticker, and

» run date in the format mmddyyyy.

To view a report, click its PDF icon. The report PDF opens. Depending on the settings in
your internet browser, you might see a Download message.

< Note: If you do not have Adobe Acrobat Reader or a similar application installed on your
system, an error message opens, containing a link to the Adobe website, where you can
download Acrobat Reader.

Batch Reporting |
Batch Management  Batch Reports
Batch > Monthly ETF Analysis = 5/25/2017 4:17 pm
Retirement Plan Factsheet | Workbook = Saved Reporis
Action a I SEEURHES Click here
N to view
Monthly ETF Analysis .
Y L this report.
[] File Name Report Created On
[[] Proshares S&P 500 Dividend Aristocrats_Morningstar ETF Analysis_NOBL_05252017 Lﬁ 5/25/2017 4:43 pm
[] ishares Edge MSCI Min Vol USA_Morningstar ETF Analysis_USMVY_05252017 @ 5/25/2017 4:18 pm
[[] vanguard S&P 500 ETF_Morningstar ETF Analysis_V00_05252017 @ 5/25/2017 4:18 pm
[] ishares Morningstar Large-Cap_Mormningstar ETF Analysis_JKD_05252017 @ 5/25/2017 4:18 pm
[] vanEck Vectors Morningstar Wide Moat ETF_Morningstar ETF Analysis_MOAT_ 05252017 @ 5/25/2017 4:18 pm
[[] wisdomTree US Quality Dividend Gr ETF_Morningstar ETF Analysis DGRW_05252017 @ 5/25/2017 4:18 pm
[] ProShares Large Cap Core Plus_Morningstar ETF Analysis_CSM_05252017 @ 5/25/2017 4:18 pm
[] sPDR® S5GA US Large Cap Low Volatil ETF_Morningstar ETF Analysis_LGLV_ 05252017 @ 5/25/2017 4:18 pm
[[] ishares Edge MSCI USA Size Factor_Morningstar ETF Analysis_SIZE_05252017 @ 5/25/2017 4:18 pm
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Creating a Batch Report Exercise 42: Download all PDFs from a batch run

6. Look through the PDFs.

'@ ProShares%20S&P%Z0500%2ODividend%ZUAristacrats_Morningslar?GZOETF%ZUAnaIysis_NOBL_0525201?[...|E EI & _|

Eile  Edit ‘iew Window Help *

-@Create' @D%|{§}@@@@@)D @
@[ )s| NE|@@®[o=]-]|H -

Click these icons to save,
Share print, or email the PDF.

Tools Comment

-

m

Multi Lans Pear Group Parformance
1 Yoar A 'Yoars. & Yoors. 10 Yaars 15 Yoars
ProSharns S6P 500 Onidend Anstoc: 652 1047 10
Large Blend =
Peorgrmoup rnk of poar goep count 775081373 1268001, 308  960i 1%
Mo ¥ 17 am 1282 630 m
Awmragn L62 1656 LT 121 617 [+
25t Parcontie: . 1836 am 1128 695 148
&0t Parcontie: (%, 170 am 1282 630 pi]
e Parcontie: im 1482 ra 1143 562 [ %]
Large Blend + Unind States
Pear group ik ofponr guepcount. 773001368 1200ci 1,288 BEcE1078
Madian &% 170 am 1254 (%] pi]
Hoeragn (1] 1656 aan 1218 618 [+
2en Parcontie: ] 1836 am 1326 695 149
I’ Sl Parcontie: &% 1m0 am 1254 &n T
e - - - - Ten Parcontie: im 1amn ra 11.46 553 [ %]
Snapshat Monthly Premiam Discount
Marmingstar Canegory US Furd large Blend. 05
Mowage W L SR SR gy ey [ U DU
Inception Dae e
Dxpense Ratio % 0% g5
Asgets 2593 610,157 42014 a4 4205 02015 4206 W 42017
Awerage Dy Vkume: 60108 Monthby Fund Flows (millions]
12 Ma Yiekd % 18 400
SIC Yield %
Distribution Frequency Ouarterdy i
Exchange Traded Nete N M -—.———L—-*hh
(——— e 44 124 s s 4206 Wae 42017
In Exercise 41: Test a batch on page 136, you viewed a PDF of a single report, which Exercise 42: Download all

you can download. You can also download all the reports in a batch run as a .zip file. In PDFs from a batch run
this exercise, you will download all the PDFs in a batch run of Monthly ETF Analysis.

Do the following:
1. Select the Batch Reports tab.

2. Select the Factsheet tab and click Monthly ETF Analysis. The view updates to display
the list of batch runs for Monthly ETF Analysis.

Batch Management  Batch Reports

Factsheet

Browse By _atch hd

Retirement Plan Workbook  Saved Reports

Note the highlighted selections.

Last Run Time

Monthly ETF Analysis | 5/25/2017 4:43 pm
Batch 12272 12/22/2016 2:01 pm
Mew Factsheet Batch 12/22/2016 1:57 pm
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Creating a Batch Report Exercise 42: Download all PDFs from a batch run

3. In the row of the run date you are interested in, click the Cloud icon. A tooltip appears,
displaying the word “Packing.” When the reports are ready, a down arrow is displayed.

Batch Management  Batch Reports

Batch = Monthly ETF Analysis
Retirement Plan Factsheet Workbook Saved Reports

Click here to begin the
downloading process.
Run Date # of Reports Download
7/16/2018 7:00 am 3 | %]

4. Click the Down Arrow.

Batch Management  Batch Reports

Batch = Monthly ETF Analysis
Retirement Plan Factsheet Workbook Saved Reports

Click here to continue the
downloading process.

Run Date % of Reports Download
7/16/2018 7:00 am g [ #]

Depending on your browser settings for downloads, one of the following happens:
» The .zip file downloads to the folder you have designated for downloads, or
» An alert opens, giving you options such as Open, Save, and Save As.

5. Unzip the file to access the report PDFs.

+ Downloads »

Share with « E-rnail Mew folder

MName

| | 1) Monthly ETF Analysis_20180716070000_53e354d8.zip

"L ProShares S&P 500 Dividend Aristocrats_Morningsta...

3{ SPDRE 55GA US Large Cap Low Velatil ETF_Mornin... The report PDFs are shown here
"L iShares Edge MSCI Min Vol USA ETF_Merningstar ET... in the Downloads folder of

"L iShares Edge MSCI USA Size Factor ETF_Morningstar... Windows Explorer.

"L iShares Morningstar Large-Cap ETF_Morningstar ET...

"L ProShares Large Cap Core Plus_Morningstar ETF An...

-

-~ VanEck Vectors Marningstar Wide Moat ETF_Morni...
"L Vanguard S&P 500 ETF_Morningstar ETF Analysis_V...
" WicdomTree US Quality Dividend Gr ETF Marningst...
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Using Components with Nonstandard Features Overview

Using Components with Nonstandard Features

Most components have properties in common with others of the same type. For Overview
instance, in many charts, you can change markers and colors. In many tables, you can

add or remove columns (data points).Additionally, charts and tables in the Returns

category offer various returns data to choose from (Return Series, Return Type, and

so on).

In this section, the focus is on the following:

» components with uncommon features or capabilities, and
» component features used to address specific usage,

You will learn how to do the following:

» expand a Holdings Similarity Matrix or Returns Correlation Matrix (page 141)

» customize a component to display multiple values (page 144)

» understand the Asset Allocations pie chart (page 146)

» compare holdings according to their most recent common portfolio date
(page 146), and

» compare holdings in a stacked bar chart (page 148).
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Using Components with Nonstandard Features

How can | expand a Holdings Similarity Matrix or Returns

Correlation Matrix?

In Holdings Similarity Matrix and Returns Correlation Matrix charts, you can expand

the chart to fill its component cell, resulting

in a more consistent and visually pleasing

presentation. To expand the Holdings Similarity Matrix or Returns Correlation Matrix
charts to fill its component cell, do the following:

1. In a Presentation Studio report, select or insert a Returns Correlation Matrix chart
and/or a Holdings Similarity Matrix chart.

2. Onthe Command bar, select the Home tab and click Workbook. The Workbook Settings

window opens.

¢ | Home | Chart Data Table
@ L L e
Investments | Waorkbook Page Chart Table

Format H '-. H Fﬁ Eechay

A = ] J ]

Text Image Divide Page  View Calculate

Setting Insert

Layout Calculate

First Trust Multi Cap Val
AlohaDEX® ETF

Benchmark 1: Russell Mid Cap Value TR USD
Benchmark 2: 53 500TR USDH
Catenonc S Fund MidCan Vales

Fieturn Diate: 3302007
Portfolia Date 8162013

Carrelation Matrix

mIEIt0E
AN @0

ReturnRisk Analysis
Torm Furicat 102402 6 ST

Zorenized T

How can | expand a
Holdings Similarity
Matrix or Returns

Correlation Matrix?

Note the highlighted selections

Returns Correlation Matrix

Performance

+ | crar sence + |« |5 280 0 R [ ER 2>

63%

Holdings Similarity Matrix

MAORNINGSTAR
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How can | expand a Holdings Similarity Matrix or Returns
Using Components with Nonstandard Features Correlation Matrix?

3. Inthe Workbook Settings window, select the Layout tab.

4. In the Table Component Settings area, from the Table Row Spacing drop-down field,
select Distributed: White Space Between Rows.

< Note: The other option is Consistent: White Space at Bottom.

Workbook Settings: Layout

Ludil les) ||| L [BE3) .| L] Ll

e Click here to select the
Data | |Layout| | Style | Pear Group | Attribution | Index Group | Asset Exposure

Layout tab

Overall Workbook

Font Font Color Page Calor Report Language
|Morningstar 1 il [_ vl [ v| [Fullow User Preference
Margins

Tep Bottom Left Right

|o,5 in e |0,4 in s |o.4 in i |o.4 in t_:_i

E! Show "Source: Morningstar Direct” at page bottom

D Show content of "Multiple" data points

[C] Display Watermark in PDF For Internal Use Only - |
Component Title Settings
Font Size Font Color Bar Style Background Color

B Ay - —— -

Text Component Settings

Font Size Font Color
12 > [ —
Table Component Settings
Table Row Spacing Mull Value Display Mode Zero Value Display Mode
lConsisbent: White Space At Bottom v] lBIank - | [Zeru - |

Select Distributed: White Space
Between Rows

oK || Cancel |
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How can | expand a Holdings Similarity Matrix or Returns
Using Components with Nonstandard Features Correlation Matrix?

5. Click OK.

Note that the chart (or charts) now fills its cell’s vertical space.

£ Home | chart Data Table Format X mE @ (Fe
an [ Ly e A - | ) (i
Investments  Workbook Page Chart Table Text Image Divide Page  View Calculate
Setting I Insert Layout Calculate
First Trust Multi Eﬂl‘l Val Emdm:k‘i Russell Mid Cap Value TR USD ﬁ!‘lﬂlpﬂ! !’3!1‘20!?
AlphaDEX® ETF oo <o i o Uon ol e 1R
it 0 ReturnTisk Anakysis ) .
w21z 530077 Teatet U T Returns Correlation Matrix
i~ Brak]
1 Arrawioed T
Brak]
Holdings Similarity Matrix
Brak]
Relative Performance
e
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Using Components with Nonstandard Features How can | customize a component to display multiple values?

Most data points return only a single value— price, Morningstar Category, and so on. How can | customize
However, some data points can have multiple values. For instance, an investment can a component to display
be available for sale in more than one country, or it can have multiple managers. multiple values?

The following data points can return multiple values:

» data points related to managers, manager history, and so on
» Wrap/TAMP Availability

» Country Available for Sale

» Country Registered for Sale, and

» Distributor.

When one of these data points has multiple values, it displays the word “Multiple.”
You have the option of displaying the expanded list.

The option to display an expanded list is available in both Application Settings and
Workbook Setting. In this example, Workbook Settings in a Snapshot table are used.

1. Select a table component displaying the word “Multiple” in a column.

@ Note: Columns B through E are hidden in the image for readability.

Snapshot
+ & Y
Country
Available
for
Szl
IroShares Large Cap Core Plus United States
vanguard S&P 500 ETF Multiple | 1yis investment s for sale
Fussell 1000 TR USD Unitad States in multiple countries.

2. Onthe Command bar, select the Home tab, then click Workbook. The Workbook
Settings window opens.

3. Select the Layout tab.

4. Click the Show content of “Multiple” data peints checkbox, then click OK to close
the window.
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Using Components with Nonstandard Features

How can | customize a component to display multiple values?

When using Workbook Settings, only dat
setting. If you use Application Settings, a

a points in this report are affected by this
Il your reports are affected.

Workbook Settings: Layout

(] || e | EEH (el J [l (il
Data | lLayout || Style | Peer Group | Attribution | Index Group | Asset Exposure

Overall Workbook

Font Font Color Page Caolor Report Language

|Verdana | l_ vl | v| [Fullow User Preference

Margins

Top Bottom Left Right

z ry r [ 2 [ : Y
|D.5 in _'_1 |D.4 in S |D‘4 in v |D,4 in :_'_1
E Show "Sourfe: Morningstar Direct” at page bottom
T
| [¥] Shew content of "Multiple” data peints | " o o .
B e C ™ This option is also available
Y For Internal Use On i 8 g 8 8
3 in Application Settings on

Component Title Settings the Layout tab.

Font Size Font Color Bar Style Background Color

12 | B[y [E— - [——— ~| [ -]

Text Component Settings

Font Color

> [ - |
Table Component Settings
Table Row Spacing

Font Size

|22

MNull Value Display Mode

Zero Value Display Mode

-

= White Space At Bottom +| [Dash

| Zero

|

Even Row Color

=) |

Odd Row Color

[

2

| DK || Cancel |

In the Country Available for Sale column,
“Mexico, United States.”

Vanguard S&P 500 ETF now shows

A |F

Snapshot

|

ProShares Large Cap Core Plus

Country
Available
for

Sale Columns B through E are

hidden for readability.
United States

Janguard S&P 500 ETF

| Mexico, United States

Russell 1000 TR USD

United States

MAORNINGSTAR
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Using Components with Nonstandard Features Why does the Asset Allocations Pie Chart sometimes display a bar chart?

When you select the Asset Exposure Component Category, the Component Bar
displays the following pie chart icons:

» Asset Allocation Pie Chart
» Asset Allocation - Single Investment (table), and
» Asset Allocation - Multiple Investment (table).

The table components display as you would expect, but on occasion, the pie chart may
display a bar chart. This component automatically converts to a bar chart if any of the
assets have negative weights.

This chart displays a pie chart
or a bar chart, depending on
the asset weights.

Why does the

Asset Allocations
Pie Chart sometimes
display a bar chart?

Portinlin Date: 773172018 Portfolin Date: /3172015

52 8 ||Assse Mliee Cazh %
[ Aazez Alloc Equity 5

.7 || Aaset Alkoc Bond %

9 | aset Al Othar %

Vanguard Target Retirement 2020 Inv - Asset Al Vanguard Target Retirement 2020 Inv - Asset Al

E g e 3 o e o = = .
Asset Exposure & B ﬂ '\'i E = ''s g g g Ny
L.Z i L b A -

Asset Exposure Asset Allocation | Asset Allocation - Single Investment table (left icon) and
Component ' Pie Chart Asset Allocation - Multiple Investment table (right icon)
Category

The Holdings Comparison template compares the holdings of two funds in the
following tables:

» Top 20 Distinct Stock & Bond Holdings (Portfolio 1 and Portfolio 2), and
» Top 20 Shares Stock & Bond Holdings (Portfolio 1 and Portfolio 2).

In these tables, the option Most Recent Common Portfolio is available. These
components do not display data over a time period. Instead, the focus is on a specific

How can | compare
funds’ holdings using
their most recent
common portfolio date?

Morningstar Direct Cloud Editions October 2018
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How can | compare funds’ holdings using their most recent

Using Components with Nonstandard Features

common portfolio date?

date. The Most Recent Common Portfolio option finds the mast recent common
portfolio date for the two funds so that the dates are always in sync.

In the Holdings Comparison template, this selection is found in the Table Settings
window when one of the following components is selected:

» Top 20 Distinct Stock & Bond Holdings (Portfolio 1 and Portfolio 2), and
» Top 20 Shares Stock & Bond Holdings (Portfolio 1 and Portfolio 2).

Top 20 Distinct Stock & Bond Holding§

ProShares Large Cap Core Flus -

Compare To Vanguard S&P 500 ETF - i

Compare Stocks and Bonds |

Portfolio Date Most Recent Portfalic |

Enter Date

[ f o Wa T TE AR TS T8 Most Recent Portfolio
Most Recent Commaon Portfolio

| Click here to display the
portfolio dates in the table

@ Top Shared Holdings g‘:ﬁ:ﬂﬁg:& Rortink Select this option

Last Month End (-1 month}
Last Quarter End

Last Quarter End (-1 quarter)
Last Year End
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Using Components with Nonstandard Features

How does the portfolio date affect the end date in a stacked bar chart?

Ina

than the most recent portfolio date, the automatically adjusts to the most recent

port

stacked bar chart representing a portfolio’s holdings, if the end date is later How does the portfolio

folio date.

In this sample, note the following:

>

>

On the toolbar at the top of the window, the end date setting for the stacked bar
chart is Last Month End, which at the time of this writing is 7/31/2017.

At the top of the stacked bar chart, the Time Period is displayed as 10/1/2012

to 4/30/2017.

date affect the end date
in a stacked bar chart?

» At the top of the pie chart, the portfolio date is displayed (4/30/2017).
Actual time period for End Date setting for
the represented data the stacked bar chart
Hgme I Chart | Data Table Format ¥ mE @ E
[Default Period - ] ol |5 Years ago * | = |Last Month End | - |:| () 1]
ents| | Time Period Start Date End Date Rolling Window Align
ents " Time Pariad "|Chart Areal
AMG Managers Emerging Opportunities 1 - Equity Sectors (GICS)
Tims Pertog: 10/1/2012 ta 4/30/2017 |
100.9
s0.0
s0.0
70.0
s0.0
s0.0
s0.0
-—‘__—H___
200 T N e s _-
20.0
1]
i 42013 1072013 47014 10/2014 4/3015 10y2015 4r2018 1oy2018 :.zr:
= En=rgy % = Mak=rials % Industrisks %%
Consumer Discretionary % Consumer Staples % Healthcar= %
= Financials % Information Technology % = Tel=om Senvic=s %
Liilities. & = Real Estal= %
merging Opportunities I - Equity Sectors (GICS)
LY
® En=rgy 2B
@ Mab=rials 45
Industrisi= i0.g
Consumer Discretionary 15.5
Consumer Staples 24
Healthcars 15.8
® Financials 1B.6
Information Techrzlogy 17.5
® Tel=com Services 0.6
Litilities: 0.7
# Real Estate 1.5
Total 100.0
Source: Mormiphgstar Direct
Portfolio date
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Using Components with Nonstandard Features How does the portfolio date affect the end date in a stacked bar chart?
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